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Introduction
The Wyse Datacenter Appliance XC utilizes Dell PowerEdge R720xd servers, the Nutanix software-defined
storage (SDS) application, and VDI components to deliver an out-of-the-box infrastructure solution for

virtual desktops and shared desktop sessions.

This document provides the tasks required to install and configure the Dell vWorkspace VDI components
on to a Wyse Datacenter Appliance XC cluster.
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2.1

2.2

System Requirements

Before proceeding with the Wyse Datacenter Appliance XC for vWorkspace setup, ensure the following
requirements are met. To successfully complete the setup, you must be familiar with the following
technologies:

e Active Directory
e Windows Server 2012 (or higher)

Supplemental Documentation
Some sections in this guide refer to the following documentation for additional details.

o VvWorkspace Administration Guide

e Foglight for Virtual Desktops Administrator's Guide

e Foglight for Virtual Desktops User's Guide

o VMWare vSphere Virtual Machine Administration Guide—ESXi 5.5 (for vSphere hypervisor
installations only)

Nutanix vSphere Adminstration Guide

Nutanix Web Console Guide

Nutanix SDS Cluster

The Wyse Datacenter Appliance XC servers must belong to a Nutanix SDS cluster.

Software

The following software is required to setup the solution:

e Microsoft Windows Server 2012 R2

e Dell vWorkspace 8.0 MR1

e  Microsoft SQL Server 2012 Standard Edition with SP1 (x64)
o All software license files

The following software is required, if using Hyper-V as the hypervisor:
o Microsoft System Center Virtual Machine Manager 2012 R2
The following software is required, if using vSphere as the hypervisor:

e VMware vSphere 5.5 GA

Wyse Datacenter Appliance XC for vWorkspace



2.3

2.4

2.4.1

2.4.2

Supported Hypervisor Platforms

The hypervisor used in this solution can be Microsoft Windows Server 2012 R2 with Hyper-V role or
VMware vSphere 5.5 GA (not Update 1 or Update 2).

Active Directory (AD)

Active Directory is required for this solution; however, configuration of AD is beyond the scope of this
document except where noted. DNS is required for name resolution. All Windows servers must belong to
the same AD domain.

Domain User Accounts

We recommend creating domain accounts to be used specifically for SQL and System Center Virtual
Machine Manager (SCVMM) services as opposed to using local system accounts.

SCVMM service account requirements:

e The domain account must be a member of the local administrators group on the VMM
management server.

e You cannot change the service account after installation. To change it, you must uninstall and then
reinstall SCVMM.

SCVMM RunAs account: Used to perform administrative tasks on systems from VMM.
SQL:

e Service account: Itis recommended to run SQL Server and related services under a domain
account (or multiple domain accounts) with minimum privilege needed to run.

e SQL administrators: domain account, group, or both with administrative access to the SQL server
and databases.

Distributed Key Management Container

VMM encrypts some data in the VMM database, and therefore, we recommend storing the encryption keys
in AD DS by using distributed key management instead of locally on the VMM management server. To set
up the necessary AD container, complete the following tasks:

1. Start ADSI Edit, right-click the root folder, select Connect To, and then click OK.
2. Select the root folder that represents AD domain structure. This should be labeled with a prefix
of DC=.

Wyse Datacenter Appliance XC for vWorkspace
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Figure 1

No AW

ADSI Edit Application

Right-click and select New - Object.

Select Container from the object class and click Next.
Enter a value for the object class. For example, VMMDKM. Click Next.
To create the new container, click Finish.

Make sure that the new container object now appears in AD.
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Figure 2 ADSI Edit
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8. Make note of the distinguished name for the container for later use in the installation. Right-
click the container and select Properties. Select the distinguishedName attribute in the list,
double-click the attribute, and then copy the value.

—

Wz ADSI Edit
File View Help
rallzc L E T i
e 2m XE o B CN=YMMDKM Properties 7] x
27 ADS|Edit Ma - - o
4 3 Default naming contest [ded Attribute Editor | S ecurity |
a [ DF::tESﬂ_,DC:EDm Attributes:
~| CM=Builtin - f
| CM=Computers Aittribute Walue ~
~ OLI:D p. Cartrol adminD ezcription <not get
. CN_FDW!EIHS Dn_;:l: adminDizplayM ame <nat zetr =
i =ForeignSecuri
Ch b D4 |
~| OU=Loginvsl . . .
% eMeLosthndFound String Attribute Editor
'—_ CH=Managed Servicr Attribuate: diztinguished™ ame
| CH=NTDS Quotas
~| CM=Program Data Value:
“ Od=SUT Ch=MMDEM D C=test1.DC=cam| |
.‘_ Chl=System Clear OF. | | Cancel |
| OU=Temp-LV3l
~| CHN=TPM Devices
7 CH=Users {5t 0R ole0wner <hot setr
= CH=WMRDER inztanceT ype x4 =[WRITE ] -
< m »

| Ok | | Cancel Apply

Figure 3 ADSI String Attribute Editor

9. Click the Security tab and add the VMM service account that you created in the earlier section
by granting full control to this object and all descendant objects of the container.
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3 Configuring Nutanix Storage Pool and Containers

To use the cluster storage, you must configure a storage pool and containers within the pool. Create only
one pool consisting of all the disks in the cluster. Within the storage pool, we recommend creating
multiple containers for a logical distinction between the compute and management storage layers.

1. To configure the storage pool and containers, log in to the Nutanix Web Console. From the
Home drop-down menu, select Storage.

NUTANIX-HYPI

Figure 4  Nutanix Web Console

2. Click the Create Container link and click the plus symbol (+) under the STORAGE POOL section
to create a pool.

Enter a name for your container and select a storage pool for it. You can mount the
container as an NFS datastore for all hosts, or select individual hosts

NAME

STORAGE POOL

No Storage Pool | g @

MAX CAPACITY

Figure 5 Create Container Wizard

13 Wyse Datacenter Appliance XC for vWorkspace



14

A storage pool is a group of physical disks from one or more tiers. Nutanix

recommends creating a single storage pool to manage all physical disks within the

Cluster.

NAME

SP1

CAPACITY

1232TB Use unallocated capacity [

Figure 6 Creating Storage Pool

3. Provide a name for the pool (for example, SP1) and use all unallocated disk space. Click Save.
On the Create Container page, to view additional settings, click the Advanced Settings button.
The recommended settings are as follows:

Replication Factor: 2

Reserved Capacity: 4096 GB (only for the “Compute” container that contains the persistent
virtual desktops)

Compression: Disabled

Delay: O minutes

Perf Tier Deduplication: On

Capacity Tier Deduplication: On (Post-Process)

NOTE: If using vSphere for the hypervisor, select Mount on all hosts under the NFS Datastore section.

4. Type a name for the management container such as "ds_mgmt” and click Save. Click
+ Container to add another container for the compute/RDSH layer. Use the same advanced
settings, provide a name (for example, ds_compute or ds_rdsh) and click Save. If you are using
desktops and RDSH on the same cluster, create an additional container for logical separation.

HV-BENSEN.O. o a@ N

Overview - Diagram - Table é
'== Storage Pool | 4 Contalners e B8
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Hyper-V Hypervisor and SMB Shares

While using Hyper-V for the hypervisor, SMB shares are used to store the virtual machine disks and settings
files. The cluster name is the "host” portion of the SMB share name. If not created during the Nutanix
cluster setup, add a DNS entry for this name and point it to the cluster IP address. The container names
that you created earlier are used as the share names. The resulting share name will be \\ {cluster-
name}\{container-name}. For example, \\cluster\ds_mgmt.

By default, only the cluster hosts have access to the SMB shares. To change this, you must modify the
Whitelist on the cluster. At a minimum, the IP address of the System Center VMM host must be added. If
you want all management hosts to be able to access, you can specify the network segment as opposed to
single IP address.

NOTE: The shares must be used only for storing VDI-related components.

To modify the Whitelist, go to the Nutanix Web Console, click the configuration wheel symbol in the
upper-right corner, and then click Filesystem Whitelists.

) ms Data R

Figure 7  Filesystem Whitelists

5. Type the desired host IP address or network segment and click Add.

15 Wyse Datacenter Appliance XC for vWorkspace



4.1

4.2

Configuring Hypervisor

Setting up Windows host

Joining Hyper-V Hosts to the Active Directory Domain

If using Windows 2012 R2 with Hyper-V role as the hypervisor, the hosts must have already been joined to

the AD domain as part of the initial Nutanix cluster setup.

Hyper-V Virtual Switches and NICs

The Nutanix cluster setup process will create a network team using the 10 GB NICs. This team is
associated with a virtual switch named “ExternalSwitch” for all external traffic to the host and VMs. There is
also a virtual switch named “InternalSwitch” which is used only by the Nutanix controller VMs (CVMs).

£ Virtual Switches
IR Mew virtual network switch
# yfy InternalSwitch

Internal anly

L] oo ExternalSwitch
Microsoft Network Adapter Multipl. ..

# Global Network Settings

[ MAC Address Range
00-15-50-2E-50-00 to 00-15-50-2,

Figure 8  Virtual Switches

This configuration is sufficient for VDI to function, but we recommend that additional virtual NICs be
created and associated with VLANs to segment the pertinent operations of the Management OS. For

o'a Virtual Switch Properties

Mame:

ExternalSwitch

Motes:

Connection type
What do you want to connect this virtual switch to?
(@) External network:

Microsoft Network Adapter Multiplexaor Driver

| Allow management operating system to share this network adapter

example, failover cluster heartbeating and live migration.

16
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In the following example, the management VLAN uses 177 as the ID and is added to the ExternalSwitch
vSwitch (this should be changed to the ID used for your management network).

A Virtual Switches . Virtual Switch Properties
YA New virtual network switch

Name:
[ExlernaISmtw
3 Ny InternalSwitch
1 J Notes:
R Global Network Settings
% MAC Address Range
Connection type

What do you want to connect this virtual switch to?

® External network:

EM»cosoﬂ Network Adapter Multiplexor Driver v

[v] Allow management operating system to share this network adapter

) Internal network

_) Private network

VLANID
/| Enable virtual LAN identification for management operating system
The VLAN identifier specifies the virtual LAN that the management operating

system will use for all network communications through this network adapter. This
setting does not affect virtual machine networking.

177

Figure 9  Virtual Switch VLAN ID
Adding Virtual NICs

Using PowerShell, you can run the Get-VMNetworkAdaptervVlan command to view current virtual NICs
and VLAN assignments.

PSS C:ullsers‘fidministrator® get-vmnetworkadaptervlan

VHHame UMHetwarkAdapt erMame Mode UlanlList
InternalSwitch Untagged
ExternalSwitch Access

HTHE-P4KEGY12-B-CUM External Untagged

HTHA-74KGY12-B-CUM Intermal Untagged

Figure 10 View Virtual NIC VLAN Assignments using PowerShell

The following PowerShell commands can be run to create additional vNICs and corresponding VLANSs.
The vNICs are associated with the ExternalSwitch virtual switch.

Add-VMNetworkAdapter -ManagementOS -Name "Cluster" -SwitchName "ExternalSwitch"

Add-VMNetworkAdapter -ManagementOS -Name "LiveMigration" -SwitchName
"ExternalSwitch"

Set-VMNetworkAdapterVlan -ManagementOS -VMNetworkAdapterName "Cluster" -Access -
VlanId 25

17 Wyse Datacenter Appliance XC for vWorkspace



Set-VMNetworkAdapterVlan -ManagementOS -VMNetworkAdapterName "LiveMigration" -
Access -VlanId 50

Make sure the corresponding VLAN tagging is configured on the physical switches that the hosts are
connected to.

NOTE: It is not necessary to create a virtual NIC and VLAN assignment for the desktops.

Network Traffic for the desktop VMs will pass through the ExternalSwitch virtual switch, but the Hyper-V
host OS does not need a connection on that network or VLAN. Therefore, if you want to configure the
desktops for a specific VLAN, the ID is added to the gold image template later in the configuration.

Verify the VLAN configuration by using Get-VMNetworkAdapterVlan.

I‘ C:\lsers\Administrator? Get-UMNetworkAdapterUlan

IHHame UMHetwarkAdapterHame Hode UlanList

LiveMigration Access 50
Cluster Access 25
InternalSwitch Untagged
ExternalSwitch Access 177
HTHE-94EGY12-B-CUM External Untagged
HTHE-?4KGY12-B-CUM Internal Untagged

Figure 11 View Virtual NIC VLAN Assignments using PowerShell

You should also be able to see the new virtual NICs (vNICs) on the local server properties in Server
Manager. We recommend assigning a static IP address to each virtual NIC.

After virtual NICs are created, the virtual switch properties in the Hyper-V Manager tool will no longer be
accessible. You must modify them by using PowerShell.

Verify that the Nutanix controller VMs are configured to access the correct VLAN. In this example, VLAN
177 is used for the management network. Therefore, we must configure the CVM network adapter with
the appropriate ID.

B Settings for NTNX-94GDY12-A-CVM on HV-BENSEN-01 M
NTHNX-34G0Y12-A-CVM v | QG
% Hardware ~/| @ Network Adapter
1] Add Hardware
& BI0S Spedfy the configuration of the network adapter or remove the network adapter.
tf Virtual switch:
s Memory ExternalSwitch v
e VLAN ID

[ D Processor

[+ Enable virtual LAM identification

§ IDE Controlier 0
— ontrerer The VLAN identifier specifies the virtusl LAN that this virtusl machine wil use for al

= B IDE Controller 1 network communications through this network adapter.
&% DVD Drive [
e 173

(= ¥ SCSI Controller

H =a Hard Drive Bandwidth Management

— o

Figure 12 Configuring the CVM network adapter
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Jumbo Frames

The Nutanix cluster setup should have configured the NICs to the largest supported MTU size (jumbo
frames). This can be verified in Network Connections. Go to the properties of the NICs for the
ExternalSwitch, Cluster, and LiveMigration, and then click Configure. Click the Advanced tab and verify
that Jumbo Packet value is set to the highest value (typically, 9014 bytes) and modify if not currently set to
the highest value.

NOTE: The NIC for the InternalSwitch will have a jumbo frame size of 64,000. This must be verified from
the registry as the GUI properties window will not display this high value properly.

NOTE: Jumbo frames must be enabled also on the physical switch.
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5 Setting up Management VMs

The table here summarizes all of the management VM specifications for the viWorkspace and Hyper-V

configuration.

Startup Dynamic Memory 05 vDisk
Role vCPU | RAM NIC Size

(GB) Min|Max | Buffer | Weight (GB) Location
Nutanix CVM (pre- 8 32 N/A N/A High 2 N/A | C: (rear)
installed)
Broker+ RD Lic 4 4 2GB|8GE 20% | Med 1 40 ds_magmt
WebAccess+SGW 2 4 512MB|6GE |20% | Med 1 40 ds_mgmt
vWaorkspace Diagnostics |2 4 512MBI6GE  [20% Med 1 &0 ds_mgmt
and Monitoring (Foglight)
Foglight Agent Manager |2 4 512MBI6GE  |20% Med 1 &0 ds_mgmit
5QL Server std. 4 g8 AGB[10GB 20% | Med 40+ |ds_mgmt

200

SCVMM 4 g 4GB|8GB 20% | Med 1 &0 ds_magmt

Figure 13 Hyper-V Management VM Table

This table summarizes all of the management VM specifications for the vWorkspace and vSphere

hypervisor configuration.

OS vDisk
Role vepu | VRAMU T e
et S Location
(GB)
Nutanix CVM 8 32 2 N/A C: (rear)
Broker + Licensing 4 8 1 40 ds_mgmt
WebAccess + SGW 2 6 1 40 ds_mgmt
SQL Server Std. 4 8 1 40 + ds_mgmt
200

vCenter Appliance 2 8 1 125 ds_mgmt
vWorkspace Diagnostics and 2 6 1 60 ds_mgmt
Monitoring (Foglight)
Foglight Agent Manager 2 6 1 60 ds_mgmt

vSphere Management VM Table

20 Wyse Datacenter Appliance XC for vWorkspace
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21

The SQL and SCVMM VMs are created first for the Hyper-V configuration followed by the remaining
management VMs. Similarly, the SQL and vCenter VMs are created first for the vSphere configuration.

Creating Management VMs

To create VMs for Hyper-V configuration:

1.

o~

10.

11.
12.
13.

Log in to any of the hosts in the cluster and start Server Manager. Any host can be logged in to
because the VMs will eventually be added as roles to a Microsoft Failover Cluster.

In Server Manager, from the Tools menu, select Hyper-V-Manager.

In Hyper-V Manager, connect to the local server.

Right-click the name of the local server in the left pane and select New > Virtual Machine.

On the Specify Name and Location page of the New Virtual Machine wizard, type the name and
location of the VM. The location is the Nutanix SMB share for your management container (for
example, \\nutanix-cluster\ds_mgmt).. For the SCVYMM VM, the server name cannot
exceed 15 characters and must not contain a "-SCVMM-" pattern.

On the Specify Generation page, specify Generation 2 and click Next.

On the Assign Memory page, type the amount of startup memory according to the Hyper-V
Shared Session VM Sizing table and select the check box next to Use Dynamic Memory for this
virtual machine. Click Next.

On the Configure Networking page, select the vSwitch previously created for the management
VLAN (the Nutanix setup identifies this as "ExternalSwitch”).

On the Connect Virtual Hard Disk page, select the Create a virtual hard disk check box, type
the name, location, and size of the virtual disk. The location will be the Nutanix SMB share for
your management container. Recommended sizes are in the Hyper-V Management VM table.
On the Installation Options page, select the Install an operating system later option. Click
Finish.

After the VM is created, right-click the VM in the Virtual Machines pane, and then select Settings.
Click Memory and adjust the settings to match those in the Hyper-V Management VM table.

In the VM settings, click Network Adapter in the left pane, and then select the Enable Virtual
LAN Identification check box. Type the VLAN ID for your management VLAN, if applicable.
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The VLAN identifier spedifies the virtual LAN that this virtual machine will use for all
network communications through this network adapter.

Bandwidth Management
[] Enable bandwidth management

@ Toleave the minimum or maximum unrestricted, spedify 0 as the value.

Figure 14 Network Adapter External Switch

14. For the SQL VM, we recommend creating four additional virtual disks: two for database and
database log files, and two for tempdb and tempdb logs. To create four additional drives, right-
click SQL VM in the Virtual Machines pane and select Settings.

15. Click the SCSI controller in the hardware pane, select Hard Drive in the right pane (under SCSI
Controller), and then click Add. Repeat the task until you have four more virtual disks.

% Hardware

“T]l Add Hardware
& Firmware
Boot from File
i Memory
3192 MB
3 rro

CESSor
4 Virtual pr
B &3 S5CSI Controller

s Hard Drive
SQL-5Test.vhdx

—u Hard Drive
S5QL-5Test_D1.VHDX
s Hard Drive
SQL-5Test_E1.WHDX
s Hard Drive
S5QL-5Test_F1.WHDX
—u Hard Drive
SQL-5Test_G1.VHDX

ExternalSwitch

Figure 15 SCSI Controller

&%l SCSI Controller

You can add hard drives to your SCSI controller or remove the SCSI controller fram the
virtual machine.

Click Add to add a new hard drive to this SCSI controller.

DYD Drive

[ |

‘fou can configure a hard drive to use a virtual hard disk or a physical hard disk after
you attach the drive to the controller.

To remove the SCSI controller from this virtual machine, dick Remowve, All virtual hard

disks attached to this controller will be removed but not deleted.

Virtual disks must be created with the following disk spaces:

e Data: 100 GB fixed

e Logs: 50 GB fixed

e TempDB data: 20 GB fixed
e TempDB logs: 20 GB fixed

16. After adjusting settings, click OK.

22 Wyse Datacenter Appliance XC for vWorkspace




17. Windows Server 2012 R2 must be installed on each of the management VMs. You can install
Windows Server 2012 R2 by attaching an .iso file to the virtual DVD or by using existing OS
deployment applications. If installing by ISO file, add a DVD Drive first by clicking SCSI
Controller in the VM Settings, highlighting DVD Drive, and clicking Add.

18. After installing the OS and applying your Windows license key, configure an IP address for the
VM.

19. Change the computer name to an appropriate host name and join the VM to your domain.

20. Repeat the tasks to create all of the necessary Windows Server VMs listed in the Hyper-V
Management VM table.

511 Creating Management VMs for the vSphere hypervisor configuration
For equivalent tasks to create VMs for vSphere, see the vSphere Virtual Machine Administration
Guide (ESXi 5.5). For the specifications to use for the VMs, refer to the vSphere Management VM
Table earlier in this guide.

5.2 Installing SQL Software

52.1 SQL Software Prerequisites

Prerequisites for the SQL Server installation:

1. Loginto the SQL VM to perform the SQL Server 2012 installation. For best performance, we
recommend formatting the additional virtual disks for data, 1ogs, tempdb, and temp logs
using a 64K allocation size before installing SQL. To format the additional drives, right-click the
partitions in Disk Management, select Format, and then select 64K from the allocation unit size
drop-down menu (if new, right-click the drive and select New Simple Volume and continue with
formatting).

NOTE: If the drives are offline, right-click the drive, select Online, right-click again, and then select
Initialize before formatting.
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Format Partition
To store data on this partition, you must format i first.

Choose whether you want to format this volume, and if so, what settings you want to use.

() Do not format this volume

(®) Format this volume with the following settings:

File system: |NTFS v]
Allocation unit size: | Rk W |
WVaolume label: | Datal |

Perfarm a quick: format

Enable file and folder compression

<Back || MNet> | | Canesl

Figure 16 Formatting Virtual Drives

2.

SQL service accounts created as outlined in the System Requirements section.

SQL Server Installation
SQL Server Installation:

1

© o N OO AW

11.

While logged in to the SQL VM, access the SQL setup files (go to file share, copy locally, insert
DVD, download, etc.)

Run Ssetup.exe, in the left pane, click Installation, and then select new stand-alone
installation.

Click OK to continue past the discovery operation.

On the Language selection page (if displayed), click Next.

On the Product Key page, enter PID, and then click Next.

Accept license terms and click Next.

Enable setup to download and use update files and click Next.

Note any warnings or issues from the report and click Next.

Select SQL Server Feature Installation and click Next.

. Database Engine Services, Management Tools (basic & completed), and SQL Client Connectivity

SDK features must be installed. Other features can be installed as required. Click Next until you
arrive at the instance configuration.

Select Default instance on the Instance Configuration page and click Next. On the Disk Usage
page, click Next.
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12. Change the SQL service accounts to the desired domain user accounts. Make sure to specify the

domain account and password. Click Next to continue.
Server Configuration

Specify the service accounts and collaticn configuration.

Setup Support Rules Service Accounts | Collation

Setup Role

. Microsoft recommends that you use a separate account for each SQL Server service,
Feature Selection

Installation Rules Service Account Name Password Startup Type

Instance Configuration SQL Server Agent INT Service\SOLSERVERAGENT JE¥ Manual v

Disk Space Requirements SQL Server Database Engine NT Service! SOLSERVERAGENT Automatic W
<< Browse..» > -

Server Configuration SQOL Server Browser P AU I T LA LR L Disabled v

Database Engine Configuration

Figure 17 Server Configuration

13. Set to mixed mode authentication, specify a password for the SA account, and add domain user(s)
or group(s) to be used for SQL administration.

14. On the DataBase Engine Configuration page, click the Data Directories tab. Change the
database, log, and temp locations to the corresponding drives configured during the SQL VM
creation. Unless you want to designate specific folders, the existing paths can be retained with
only the drive letter being changed (for example, D: \Program Files\Microsoft SQL
Server\MSSQL11.MSSQLSERVER\MSSQL\Data). Click Next.

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules Server Configuration | Data Directories | FILESTREAM

Setup Role
Feature Selection Data root directory: |C:\Program Files\Microsoft SOL Server\| | II'
Installation Rules System database directory:  C:\Program Files\Microsoft 501 Server\M550L11.MSSQLSERVER\MSSOL\Data
Instance Configuration - -

User database directory: |D:\Program Files\Microsoft 50L Server\MS50QL11.M550LSERVER\MS5CL\Data | I:l
Disk Space Requirements
Server Configuration User database log directory: |E:\Program Files\Microsoft 50L Server\MS50QL11.M550LSERVER\MS5CL\Data | II'
Database Engine Configuration Termp DB directory: [F\Program Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\Data | II'
Error Reporting
Installation Configuration Rules Temp DB log directory: |G:\Program Files\Microsoft SOL Server\MS55QL11.MSSCLSERVER\MSSOL\Data | I:l
Eeadviopeial Backup directory: [C:\Program Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\Backup | II'
Installation Progress

Figure 18 Database Engine Configuration

15. Click Next on the Error Reporting and Next again on Installation Configuration Rules.
16. To begin installation, click Install and after completing the installation process, click Close.
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Installing System Center VMM Software

NOTE: SCVMM is only required when the hypervisor is Hyper-V.

Log in to the SCVMM VM to perform the SCVMM prerequisites and installation tasks here.

SCVMM Software Prerequisites
Windows ADK for Windows 8.1

Download the Windows ADK for Windows 8.1 installation file available at Microsoft website:
http://www.microsoft.com/en-US/download/details.aspx?id=39982

Run adksetup.exe and accept the default location.

Select No to the customer experience program and click Next.

Accept the license agreement.

Only the Deployment Tools and Windows Preinstallation Environment features are required.
Select only necessary options and click Install.

5. Click Close.

> =

SQL Native Client and Command Line Utilities

Download and install the SQL Server 2012 Native Client and Command Line Utilities available on Microsoft
Web site:

e SQL Server Native Client: http://go.microsoft.com/fwlink/?LinkiD=239648
e SQL Command Line Utilities: http://go.microsoft.com/fwlink/?LinkID=239650

To install the SQL Native Client, run sglncli.msi.

Accept license agreement and click Next.

Only the client components are necessary. You must not install the SDK.
Click Next, and then click Install to begin.

Click Finish when complete.

To install the SQL Command Line Utilities, run Sqg1CmdLnUtils.msi.
Accept license agreement and click Next.

Click Install to begin.

Click Finish to complete.

O N U~ WNE
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.NET Framework 3.5

.NET Framework 3.5 is required for the vWorkspace Broker Helper service.

no

o Uk W

In Server Manager, click Manage and select Add Roles and Features.

On the Before You Begin page, click Next, select Role-based or feature-based installation, and
then click Next.

The local server should be selected as the destination. Click Next.

Click Next on server roles without selecting any roles.

Select .NET Framework 3.5 and click Next.

Select the Restart the destination server automatically if required check box and click Install.

Windows Server 2012 R2 is used for the OS for the VMM management server and has the following
required components installed by default:

¢ Windows Remote Management service (WinRM 3.0)
e NET Framework (version 4.5)

SCVMM |nstallation

System Center VMM Installation

1

© ® N hWDN

10.

11.
12.
13.
14.

Add the previously created VMM service account to the local administrators group on the VMM
server (see the System Requirements section in this document).

Run setup and select Install.

Select VMM management server. The console is installed by default.

Type your product key.

Accept the license.

Select Yes or No for customer experience.

Select On or Off for updates.

Click Next on default installation location.

Browse through or specify the previously created SQL database server that is used to host the
database. If using a port different than the default 1433, specify it. If installing with an account
that doesn't have permissions to the SQL server, specify appropriate credentials. Instance name
must be present (default of MSSQLSERVER). Enter desired database name or leave the default
and click Next.

Type the VMM Service Account and Distributed Key Management container details (see the
System Requirements section in this document) and click Next.

Use the default port values, and then click Next.

Select Create a new library share on the VMM management server and click Next.

Review the installation summary and click Install.

After setup is complete, click Close twice.
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15. If you left the checkmark next to Open the VMM console check box, the Connect to Server
window is displayed. Otherwise, click the Console icon on the desktop. Connect to the VMM

Console.
= Microsoft System Center 2012 R2 Virtual Machine Manager Setup Wizard -
Complete Report a problem

Setup completed successfully

For detailed information, review the Setup log files that are located in the %SYSTEMDRIVE?%\ProgramData\VMMLogs folder.
Note that the ProgramData folder is a hidden folder.

Gvmm management server o

@ VMM console Release Notes

Installation Guide
Read Documentation

System Center Online

Check for the latest Virtual Machine Manager updates
Open the VMM console when this wizard closes

Close

Figure 19 SCVMM Installation Screen

vWorkspace Broker Helper Service for SCVMM:

1. ForvWorkspace 8.5 and later, use the Broker Helper Service (BHS) installer included with the
vWorkspace installation files. For vWorkspace 8.0 MR1, download the Broker Helper Service
(hotfix ID #412931) from :

https://support.software.dell.com/vworkspace/8.0.1/category/Patches
2. The BHS relies on CredSSP. To enable properly, log in to each Nutanix/Hyper-V host and run
the following from an elevated administrator PowerShell command prompt.

Enable-WSManCredSSP -Role server

When prompted, select Y and press Enter. Type Get-WSManCredSSP to verify the setting. The
following message is displayed.

The machine is not configured to allow delegating fresh credentials.
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This computer is configured to receive credentials from a remote client
computer

3. Onthe SCVYMM VM, enter the following from at an administrator PowerShell command prompt.
The computer names must be the FQDN of each Nutanix or Hyper-V separated by commas
along with the Microsoft Failover Cluster (MFC) name associated with the cluster:

Enable-WSManCredSSP —-Role Client -DelegateComputer
Hostl.domain,Host2.domain, Host3.domain, MFC name.domain

When prompted, select Y and press Enter. Enter Get-WSManCredSSP to verify the setting. The
response should be as given here (the target names are just examples).

The machine is configured to allow delegating credentials to the
following targets: wsman/NTNX-HV-MFC.osprey.com,wsman/HV-Bensen-
03.osprey.com,wsman/HV-Bensen-02.osprey.com, wsman/HV-Bensen-
0l.osprey.com, WSMAN/*

This computer is configured to receive credentials from a remote client

computer.
4. Runthebrokerhelper.exe to begin the installation.
5. Click Next on the Welcome page. Accept the license and click Next.
6. Type user name and organization, and then click Next.
7. Click Install. Click Finish when completed.
8. Reboot the system.
5.4 Installing vCenter Server Appliance

NOTE: vCenter is required only when the hypervisor is vSphere.

The VMware vCenter VM will be created using the VMware vCenter Server Appliance. The VMware vCenter
Server Appliance is a preconfigured Linux-based virtual machine that is optimized for running vCenter
Server and associated services. Visit the VMware website for information on downloading version 5.5.0 and
licensing.

1. Connect to one of the Nutanix configured ESXi hosts using the VMware vSphere client.
2. Inthe VMware vSphere client, click File > Deploy OVF Template.
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Figure 20 Deploy OVF Template

3. Inthe OVF deployment wizard, click Browse, select the vCenter Appliance OVF template file, and then
click Next.

Confirm the template details and click Next.

Specify a name for the vCenter Server Appliance VM and click Next.

Select the datastore you created for your management VMs as the storage location and click Next.
Select Thin Provision for disk format and click Next.

Review the settings and click Finish to deploy.

The vCenter Appliance deployment will now run.

9. After deployment, the vCenter Appliance VM will appear listed under the ESXi host in the vSphere

client window.
[=¥ 10.50.192.43 - vSphere Client

@ N oo s

File Edit View Inventory Administration Plug4ns Help

@ @ |E§ Home [ gF] Inventory b@ Inventory
& &

= [ [1050.192.43 kbcmfEsxi VMware ESXi, 5.5.0, 1230948
G vMware vCenter Server Appliance e s el Summary | Virtual Machines

What is a Host?

A host is a computer that uses virtual
as ESX or ESXi, to run virtual maching
CPU and memory resources that virtu
give virtual machines access to stora
connectivity.

You can add a virtual machine to a he

Figure 21 vCenter Appliance

10. Turn on the vCenter Appliance VM and click the Console tab to view the on-screen Quick Start Guide.
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Figure 22 vCenter Appliance VM Console

11

Open a web browser window to the URL indicated in the Quick Start Guide (displayed on the console
screen) and type the User Name root and Password vmware, and then click Login.

e —

VMware vOenter Server App X

C A (xb##ps://10.50.184.2
% apps [ Fogioht - Environment % Bensen View Administ . (4) Bensen vSphere Web [T Mutanix Web Console

o¢° VMware vCenter Server Appliance

User name. root

Figure 23 vCenter Appliance login screen

12.
13.
14.

15.

Accept the EULA and click Next.

Click Next to skip the Customer Experience Improvement Program page.

If using a static IP address, you must close the wizard and set a hostname. In this guide, a static IP
address will be used. Click Cancel to exit the wizard.

Click the Network tab, select Address, and from the IPv4 Address Type drop-down menu, select
Static.
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QQ-Q VMware vCenter Server Appliance

Network Help | Logout user root

Network Address Settings. Please restart the appliance after changing the network configuration.
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IPvE Address Type
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Figure 24 Static IP Address
16. Set the Hostname and IPv4 address settings. Click Save Settings.

Note: The fully qualified domain name (FQDN) format must be used for the host name.

17. When the network settings have saved, change the URL on the web browser to the static IP address
you just set, and log in again using the login ‘root’ and password 'vmware’, and then click the Network
tab to verify your IPv4 settings.

18. Click the vCenter Server tab and under the Utilities section, and then click the Launch button to
restart the Setup Wizard.

s?-;f VMware vCenter Server Appliance

[ —_—" | . .. | Help | Logoul ussr mosl

| Summary  [JEETTTR 550 | Tme |Aumenticaton| Services Sorage
Summary
wCenter Storage Usage
Sarver Stopped Start System 3%
Irvantory Service Stopped S2ar Diatabase 1%
Database: not configured Logs 1%
550 nadt configured Coredumps 1%
Configurs Database | Configurs S50
Litibities
System Sippart bunde Davnload
Tirmse symchionzaton Doizabled Configuration B Dewnioad
Autrve Dirsclory Deisabled
| setup wizara Launch | |
Configure Time | Configure Authentication
Syspeep files Uipload
Sarvices
v3phete Web Chent Running Siop
Log Browser Stoppad Stan
ESxi Dump Colecior Running Stop
Syshog Collachor Running Stop
vSphene Auto Deploy Stopped Stan

Configurs Services

Figure 25 Setup wizard re-launch
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19.
20.
21

22.

23.

24.

25.
26.

Do not change selections on the Customer Experience Improvement Program page, click Next.
Select the Set custom configuration check box and click Next.

For this solution, the embedded database option will be used. Accept the default database settings
and click Next.

Select embedded for the SSO deployment type, type a password for the administrator@vsphere.local
user, and then click Next.

To configure Active Directory authentication, select the Active Directory Enabled check box and enter
the domain name to authenticate to, along with an administrative user login and password for that
domain.

Click Next.

Review the configuration settings and click Start

When the setup wizard completes its configuration processes, click Close.
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5.5

Installing vWorkspace Broker

The following tasks describes the process of installing the vWorkspace broker components:

1

Log in to the vWorkspace broker VM.

In Server Manager, click Manage > Add Roles and Features, click Next and select Role-based
or Feature-based installation. Click Next. Make sure the broker VM is the selected server and
click Next.

page.

4

Select Remote Desktop Licensing from the list.

In the left pane, click Remote Desktop Services, and click Next until you see the Role services

In the Add Roles and Features Wizard dialog box, ensure that the Include management tools
check box is selected and click Add Features.

L =1 =

=

Al Roles and Features Wizard

Select role servi

Role Services

Add Roles and Features Wizard

Add features that are required for Remote Desktop
Licensing?

The following tocls are required to manage this feature, but do not

have to be installed on the same server.

4 Remote Server Administration Tools
4 Role Administration Tocls
4 Remote Desktop Services Tools

[Tocls] Remote Desktop Licensing Tools

Include management tools (if applicable)

‘ Add Features‘ ‘ Cancel ‘

DESTIMATION SERVER
H-BEMSEMN-01.OZPREY.COM

X

ion

Desktop Licensing (RD

[} manages the licenses

to connect to a Remote
Session Host serverar a
lesktop, You can use RD

b to install, issue, and track
ability of licenses.

Install

Cancel

Figure 26 Add Roles and Features Wizard

5. Click Next to continue. Confirm the selections and click Install.
6. Click Close when completed.

NOTE: Appropriate remote desktop licenses must be added.

7. Access the vWorkspace setup files (go to file share, copy locally, insert DVD, download, etc.).
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8. Right-click the start.exe file, and then run as an administrator.

9. Click the Install button to begin.

10. Click Yes in the .NET Framework dialog box, and then click Next.

11. Accept the license agreement and click Next.

12. Type your user name and organization information and click Next.

13. Select Advanced setup type and click Next.

14. Select only Connection Broker Role and vWorkspace Management Console Role
(Management Console on version 8.5 and later) features and click Next.

15. Select the Create a new database on an existing SQL Server check box and click Next.

16. Specify your database configuration information using the SQL server name and SA password
created during the SQL installation. The data source and database names can be modified as
desired but we recommend to leave the vWorkspace login name as “pnadmin”. Also, specify a
unigue password for the vWorkspace login. Click Next.

i Quest vWorkspace x64 - InstallShield Wizard ILI

Management Database Configuration

Spedify the required database settings.

Data Source Name: |v\“a’0rkspace Database

SQL Server Name: |D\.'5a\.-w55QL

SA User Name: |sa

SA Password: || sesssens |
Confirm Password: || ssssnnee |
Database Name: |v\“a’0rkspace_Database

vWorkspace Login Name: |pnadmin

vWorkspace Login Password: || [ ——— |

Confirm Password: || sesssssnnns |

InstallShield

| < Back ” MNext = | | Cancel |

Figure 27 Management Database Configuration

17. Click Finish when completed.

18. You will be prompted to view a Web site with a list of hotfixes. Click Yes and download the
hotfixes listed here. Install these after restarting and completing the installation.

19. Click Yes to restart and complete the installation.

For vWorkspace version 8.0 MR1, apply the following vWorkspace hotfixes which can be downloaded from
https://support.software.dell.com/vworkspace/8.0.1/category/Patches:

e 321755
o 327208
e 333063
e 333739 (Hyper-V configuration only)
e 331043

35 Wyse Datacenter Appliance XC for vWorkspace



o 342720 (vSphere configuration only)

551  Applying vWorkspace Licenses

To apply your vWorkspace license:

1. Open the vWorkspace Management Console.
2. From the File menu, select Licensing.
3. Select the Licenses option.
4. Click the Add License button.
5. Browse to the location of your ASC license file (provided by Dell Licensing team).
6. Select the file and click Open.
7. On the message window stating the license has been added, click OK.
8. Click Close.
5.6 Installing vWorkspace Web Access and Secure Gateway

The following tasks describe the process of installing the Web Access and Secure Gateway components:

1. Login to the vWorkspace Web Access/Secure Gateway VM.

2. Access the vWorkspace setup files (go to file share, copy locally, insert DVD, download, etc.).

3. Right-click the start.exe file and run as administrator.

4. Click the Install button to begin.

5. Click Yes in the .NET Framework dialog box, and then click Next.

6. Accept the license agreement and click Next.

7. Type your user name and organization information and click Next.

8. Select the Advanced setup type and click Next.

9. Select only the Web Access Role and Secure Gateway Role (Secure Access Role in vWorkspace
8.5 and later) features and click Next.

10. Enter a name for the Web Access site. This name will also be a virtual directory in 1IS and will be

used in the URL when accessing your desktops or published applications. We recommend not to
use white spaces or special characters. Click Next after typing the name.

11. Click Install to begin and Finish when completed.

12. You will be prompted to view a website with a list of hotfixes. Click No to proceed.

13. Click Yes to restart and complete the installation.

14. After the system restarts, log in again, and then click the Web Access Site Manager icon on the
desktop.

15. The site manager displays the Friendly Name and Virtual Directory name that was configured
based on the Web Access site name you provided previously. If you want to change the friendly
name, select the existing name by clicking Edit. Remember the friendly name because this will
be used when configuring Web Access.

16. To configure the roles, see the "Configuring Web Access and Secure Gateway” section in this
document.
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Installing Foglight for Virtual Desktops

Foglight account requirements:

¢ Administrator access to all machines requiring a Foglight agent.

e An administrator password for Foglight. The user name foglight and the default password for this
account can initially be used to log in to the browser interface and to use command line interface
options with administrator privileges. It is recommended that you change the default password for
this account.

The following procedure describes the process of installing the Foglight for Virtual Desktops component
for vWorkspace 8.0 MR1:

O O N0~ W

11.
12.

Log in to the vWorkspace Foglight for Virtual Desktops VM.

Access the vWorkspace setup files (go to file share, copy locally, insert DVD, download, etc.).
Right-click the start.exe file and run as administrator.

Click the Install button.

Click Yes in the .NET Framework dialog box, and then click Next.

Accept the license agreement and click Next.

Enter your user name and organization information and click Next.

Select the Advanced setup type and click Next.

Select only Reporting and Logging Role and Foglight for Virtual Desktops Role features and
click Next.

. You can select to run a discovery now or after the installation has completed. To run the

discovery now, click Yes.

Select Connect to an existing database and click Next.

Specify your database configuration information using the SQL server name created during the
SQL installation. The database name and vWorkspace login and password must match what was
previously used when configuring the broker. Click Next.

iz Quest vWorkspace x64 - InstallShield Wizard \LI
Management Database Configuration

Specdify the required database settings.

Data Source Name: |\rWurkspa[E Database

SQL Server Name: bvs-vwssol]

SA User Name: |

SA Password: |

Confirm Password: |

Database Name: |v\"a’orkspace7Database

vWorkspace Login Name: |pnadmin

viWorkspace Login Password: “ [ —— |

Confirm Password: “ SRR EERREEY |
InstallShield

| < Back ” Next = | | Cancel |

Figure 28 Management Database Configuration
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13.

14.

15.

16.

17.

18.
19.

20.

21

22.

23.

24.

25.

26.

27.

28.
29.

30.

31.
32.
33.

34.
35.
36.

The main installer extracts files and spawns another installation process. Click Next on the
Foglight for Virtual Desktops introduction window.
Accept the license agreement and click Next.
Select Custom Install and click Next.
Select the location where you want to install Foglight. You can accept the default location
C:\Quest Software\Foglight or click the Browse button to navigate to another location.
Click Next.
Select the location where you want to create product icons. Select the Create Icons for all
Users option to create shortcuts for all Foglight users. Click Next.
Select Enable Foglight as a Service and click Next.
Review the installation information. If you are satisfied with the parameters of your installation,
click Install. To make changes to the installation parameters, click Previous.
In the Foglight Administrator Password box, accept the default password (foglight) or type an
alternate one. In the Retype Administrator Password box, accept the default (foglight) or, if you
have provided an alternate password, retype the password for verification. Click Next.
Select Standalone server mode and click Next.
In the Foglight Database Account User ID box, accept the default user ID (foglight) or type an
alternate one. This is the name for the Foglight user that you are creating. The Management
Server uses this account to store data in the database.
In the Foglight Database Account Password box, accept the default password (foglight) or type
an alternate one.
In the Foglight Database Account Retype Password box, accept the default (foglight). Or, if you
have provided an alternate password, retype the password for verification.
From the Foglight Database list, select External.
From the DB Type list, select SQL Server.
In the DB Host box, type the database host name (that is the SQL VM host name that was
previously created).
In the DB Port or Instance box, type 1433.
In the DB Name box, type the name of the database (the default is foglight).
Select Now for the Setup DB option and type the SQL administrator account user ID (sa) and
password.
Click Next.
Unless you want to adjust the port settings, retain the default values and click Next.
Specify the path to the Foglight license file in the Install a license from the following file box.
Or, browse to a license file by clicking the Browse button. Alternatively, you can provide a
license file to the Management Server after the installation is complete. To do so, leave the
License File box blank. Click Next.
Click the Done button in the Install Complete window.
The installer starts Foglight and opens the Foglight Server Startup page in a Web browser.
The Foglight Server Startup page displays information about the status of Foglight as it starts up,
such as:

The number of services that have started and cartridges that are enabled.

The latest status of the Management Server as it starts.
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37.

38.
39.
40.
41.

42.
43.

44.

45.

46.

Figure 29

47.

48.

A list of the Foglight services that are starting. Services listed in grey have not yet started,
services listed next to a blue circle are starting, and services listed next to a green square with a
check mark have started.
The information on the page is updated as Foglight starts. The page also includes a link that
allows you to refresh the page. When the server startup is complete, a link to the Foglight login
page appears. Close the browser window.
Click Finish on the original vWorkspace installation window.
Click No when prompted to visit the hostfixes website.
Click Yes when prompted to restart the system.
After the Foglight VM has restarted, open the vWorkspace Management Console, and then click
the Diagnostics & Monitoring link underneath vWorkspace Farm in the upper left corner.
Click Yes if prompted with a certificate security alert.
The system will automatically log you in. The default user name and password are both set to
foglight.
If you did not perform a discovery during installation, click the link Discover and Configure
Foglight for My Virtual Desktop Environment.
Click the Manage Credentials link to specify the Windows domain credentials to access
components in your virtual desktop environment.
Under Managing Credentials, click the Add button to enter the credentials.

Step 1 - Managing Credentials

Here you can add credentials, or remove existing credentials. You typically need to add
credentials for each new domain you want to monitor,

To map hosts to a credential, select a credential then dick the "Map Hosts" button, A
credential will NOT be used until hosts have been mapped to it. To display the list of
hosts currently mapped to a credential, dick in its "No. of Mapped Hosts" cell.
MNumber of unmapped hosts : 0

© add | Remove Map Hosts Search 2~

Domain Username No. Of Mapped Hosts
There Is Mo Data To Display

Managing Credentials

Click the Release Lockbox link under task 2 and enter the lockbox password (the default is
foglight). We recommend to also change the lockbox password.
Click Add to specify your vWorkspace Farm.

49. Type a unique identifier for your farm and click Next.
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Discover Dell vilforkspace Environment

S—

Configuration Database Details This wizard will guide you through the steps required to discover and monitor your Dell viWorkspace
environment.

Web Ac S d 5 Gati
Se‘:up R sy Please complete the field below to allow your Dell viWorkspace farm to be discovered.

« Enter a unique identifier for the farm to be discovered

Discovered Environment to be Monitored « Choose where you wish to discover your environment from

Discovered Web Access Servers

Unique Farm Identifier™ : [austin DVS Lab 5]
Discovered Secure Gateways
Discovered Brokers Discover Environment From™: Idewsfngl\ghl‘dvs.mm v 8
Discovered Databases Changing this defaulf value is discouraged without first consulting Quest Techmical Support.

Discovered Print Servers
* indicates 3 mandatory field.
Discovered User-Profiles Servers

ST

Figure 30 Discovery Setup

50.

n

n

N

Click the Configure Database Details button and type the information to connect to the
vWorkspace database. Make sure to change the database instance from "VWORKSPACE" to
"MSSQLSERVER" (default instance) or type port as 1433. You can click the Test button to ensure
the details are correct, and then click OK. Click Next to continue.
Set Database Detailz x
Database Host Name or 1P*: [DVS-NSSQL. dvs.com 1]
i = o
Database Name* : [vWorkspace_Database 1]
Database Username* : |pnadmin (1]
Database Password® : [seesssarens (1]
Confirm Password* : [seesssasens 1]

* indicates a mandatory field.

** indicates one of the options must be chosen and a value provided.

Test| 0K| Cancel |

Figure 31 Set Database Details

51.

52.

53.

54.

55.
56.

Click the Add button to enter information about your Web Access and Secure Gateway servers if
necessary.

Click the Discover Environment button to begin discovery. If a discovery has already been
completed (that is during installation) then click Next.

After discovery is completed, click OK, and then click Next to view different wizards and fine
tune the settings.

The Discovered Environment to be Monitored page displays components that were discovered.
Click Next.

Verify your Web Access server(s) , if already configured, and then click Next.

Click Next on the Discovered Secure Gateways section.
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} Discover Dell viWorkspace Environment

» Web Access Server and Secure
Gateway Setup

i

Discovered Environment to be
Monitored

Discovered Web Access Servers
Discovered Secure Gateways

Discovered Brokers

> Discovered Databases

Discovered Print Servers
Discovered User-Profiles Servers
Discovered Terminal Servers
Virtual Desktops

VMware Configuration

Hyper-V Configuration

App-V Configuration

> Confirm Environment to be Monitored

ox
manually entered.
From version 7.5, depending on how your is setup, the confi jon database will hold A
lrrfwmawnabomwebac(ussevvers.Inﬂls(asenlsnotnecmarvwmanualyadddmfume
web access servers. Secure gateways will still need to be added manually.
Use the tables below to provide the details for the web access servers and secure gateways that you
wish to monitor.
Once all the details have been entered as required, dick the "Discover Environment” button below to
complete the discovery process.
« Each web access server and secure gateway should have a name, a fully qualified host name
and a port number on which it is listening.
« Web access servers also require that the Web application root be defined.
© Add Web Access Server Remove Web Access Sesver| Search P
Name Host Name Port URL
There Is No Data To Display
© Add Secure Gateway | Remove Secure Gateway | Search P~
Name Host Name Port
There Is No Data To Display
Please diick on the "Discover Environment " button to discover the of the Dell k
instaliation that can be monitored. If you have already discovered your environment and want to stop
monitoring components or change from where they are monitored please dick "Next".
The process of ing your Dell rk can take several minutes.
v

Figure 32 Foglight Configuration Screen

57. Verify your broker and click Next.
58. Verify your database and click Next.

59. Click Next until the Hyper-V Configuration page is displayed. The Hyper-V hosts should have
been discovered but you must specify credentials to connect to the servers. Select the check
box to select all of the hosts and click the Credentials button. Type the credentials in the dialog
box and cllck OK. Cllck Next to continue.

&
(=
el

=pe bot'n®ew ged Lhen rrieacinsg B

Harnagng Credertiak, therdirr, imenbent sddng cordentiahy b the Foghht for Vietaal

Chk b e urther indormaton,

st‘pmv:-lm

Domaan:
| =148 [i]
Creder Ly | ﬁ
Tams Fopeond I!HHH! 'ﬂ
o ot Pt [aasares

Test Cradental Fepm: Iiuﬂdt’l.!um w
e [t )0
(= 1]

fon F - Mananlnn the | ko

Figure 33 Add Credential
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60. Click Next on the App-V Configuration page.

61.

Click Finish.

Apply the following vWorkspace hotfixes:

e 331043

The following procedure describes the process of installing the Foglight for Virtual Desktops component
for vWorkspace 8.5 and later:

O o NOU A~ WDdDE

[y
o

= e
N

Log in to the vWorkspace Foglight for Virtual Desktops VM.

Access the vWorkspace setup files (go to file share, copy locally, insert DVD, download, etc.).
Right-click the start.exe file and run as administrator.

Click the Install button.

Click Yes in the .NET Framework dialog box, and then click Next.

Accept the license agreement and click Next.

Enter your user name and organization information and click Next.

Select the Advanced setup type and click Next.

Select only the Monitoring and Diagnostics Role feature and click Next.

. You can select to run a discovery now or after the installation has completed. To run the

discovery now, click Yes.

. Select Connect to an existing database and click Next.
. Specify your database configuration information using the SQL server name created during the

SQL installation. The database name and vWorkspace login and password must match what was
previously used when configuring the broker. Click Next.

iz Quest vWorkspace x64 - InstallShield Wizard \LI
Management Database Configuration

Specdify the required database settings.

Data Source Name: |\rWurkspa[E Database

SQL Server Name: bvs-vwssol]

SA User Name: |

SA Password: |

Confirm Password: |

Database Name: |v\"a’orkspace7Database

vWorkspace Login Name: |pnadmin

viWorkspace Login Password: “ [ —— |

Confirm Password: “ SRR EERREEY |
InstallShield

| < Back ” Next = | | Cancel |

Figure 34 Management Database Configuration

13.

14

The main installer extracts files and spawns another installation process. Click Next on the
vWorkspace Monitoring and Diagnostics introduction window.

. Accept the license agreement and click Next.
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15.
16.

17.

18.
19.

20.

21.

22.

23.

24.

25.
26.
27.
28.

29.
30.

31.
32.
33.
34,
35.
36.
37.

38.

39.

Select Custom Install and click Next.

Select the location where you want to install Foglight. You can accept the default location

C:\Quest Software\FoglightvDesktops or click the Browse button to navigate to
another location. Click Next.

Select the location where you want to create product icons. Select the Create Icons for all
Users option to create shortcuts for all Foglight users. Click Next.

Select Enable to enable as a service and click Next.

Review the installation information. If you are satisfied with the parameters of your installation,
click Install. To make changes to the installation parameters, click Previous.

In the Administrator Password box, accept the default password (foglight) or type an alternate
one. In the Retype Administrator Password box, accept the default (foglight) or, if you have
provided an alternate password, retype the password for verification. Click Next.

Select Standalone server mode and click Next.

Select SQL Server (External database) and click Next.

In the DB Host box, type the database host name (that is the SQL VM host name that was
previously created).

In the Database Account User Name box, accept the default user ID (foglight) or type an
alternate one. This is the name for the Foglight user that you are creating. The Management
Server uses this account to store data in the database.

In the Database Account Password box, accept the default password (foglight) or type an
alternate one.

In the Database Account Retype Password box, accept the default (foglight). Or, if you have
provided an alternate password, retype the password for verification.

In the DB Name box, type the name of the database (the default is foglight).

Type the SQL administrator account user ID (Sa) and password and click Next.

Unless you want to adjust the port settings, retain the default values and click Next.

Specify the path to the Foglight license file in the Install a license from the following file box.
Or, browse to a license file by clicking the Browse button. Alternatively, you can provide a
license file to the Management Server after the installation is complete. To do so, leave the
License File box blank. Click Next.

The installation begins and the vWorkspace Monitoring and Diagnostics startup page displays
the progress.

A Web browser window will open displaying the vWorkspace Monitoring and Diagnostics
console. Copy the URL to the page as you will need to specify it later. Close the browser
window.

Click the Done button in the Install Complete window.

Click Finish on the original vWorkspace installation window.

Click No when prompted to visit the hostfixes website.

Click Yes when prompted to restart the system.

After the Foglight VM has restarted, open the vWorkspace Management Console, and then click
the Diagnostics & Monitoring link underneath vWorkspace Farm in the upper left corner.
Click the Properties link and specify the URL to the Monitoring and Diagnostics console along
with the user name and password.

Click OK and click OK on the dialog box.
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40. The system will log you in automatically using the user name and password that you specified.

41. If you did not perform a discovery during installation, click the link Discover and Configure
Foglight for My Virtual Desktop Environment.

42. Click the Manage Credentials link to specify the Windows domain credentials to access
components in your virtual desktop environment.

43. Under Managing Credentials, click the Add button to enter the credentials.

Step 1 - Managing Credentials

Here you can add credentials, or remove existing credentials. You typically need to add
credentials for each new domain you want to monitor.

To map hosts to a credential, select a credential then dick the "Map Hosts" button, A
credential will NOT be used until hosts have been mapped to it. To display the list of
hosts currently mapped to a credential, dick in its "No. of Mapped Hosts" cell.

MNumber of unmapped hosts : 0

© add | Remove Map Hosts Search 2~

Domain Username No. Of Mapped Hosts
There Is Mo Data To Display

Figure 35 Managing Credentials

44 Click the Release Lockbox link under task 2 and enter the lockbox password (the default is
foglight). We recommend to also change the lockbox password. Click Close.

45. Click Add to specify your vWorkspace Farm.

46. Type a unique identifier for your farm and click Next.

Discover Dell vWorkspace Environment
e

Configuration Database Details This wizard will guide you through the steps required to discover and monitor your Dell viWorkspace

environment.
;\;&:E:(cess S BEy Please complete the field below to allow your Dell vivorkspace farm to be discovered.

rs

Discovered Emvironment to e Monitared + Enter a unigue identifier for the farm to be discovered
s Choose where you wish to discover your environment from

Discovered Weh Access Servers

Unique Farm Identifier® : Jaustin Dvs Lab (1]
Discovered Secure Gateways
Discovered Brokers Discover Environment From™: Idewsfugl\ghtdvs.com v @
Discovered Databases Changing this defaulf value is discouraged without first consulting Quest Technical Support.

Discovered Print Servers

* indicates a mandatory field.
Discovered User-Profiles Servers

S P

Figure 36 Discovery Setup

47. Click the Configure Database Details button and type the information to connect to the
vWorkspace database. Make sure to change the database instance from "VWORKSPACE" to
"MSSQLSERVER" (default instance) or type port as 1433. You can click the Test button to ensure
the details are correct, and then click OK. Click Next to continue.
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Database Host Name or IP*: |DVS-vWSSQL.dvs.com (7]
q
() Database Instance™*:
- N [1433 o
(@) Database Port*™:
! Database Name* : [vWarkspace_Database (5]
Database Username™ : |pnadmin (1]
| Database Password® : [sessseesees (1]
Confirm Password* : |.'l. ITTTTT] 6

* indicates a mandatory field.

** indicates one of the options must be chosen and a value provided.

Test| 0K| Cancel |

Figure 37 Set Database Details

48. Click the Add button to enter information about your Web Access and Secure Gateway servers if
necessary.

49. Click the Discover Environment button to begin discovery. If a discovery has already been
completed (that is during installation) then click Next.

50. After discovery is completed, click OK, and then click Next to view different wizards and fine
tune the settings.

51. The Discovered Environment to be Monitored page displays components that were discovered.
Click Next.

52. Verify your Web Access server(s) , if already configured, and then click Next.

53. Click Next on the Discovered Secure Gateways section.
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} Discover Dell viWorkspace Environment

» Web Access Server and Secure
Gateway Setup

i

Discovered Environment to be
Monitored

Discovered Web Access Servers
Discovered Secure Gateways

Discovered Brokers

> Discovered Databases

Discovered Print Servers
Discovered User-Profiles Servers
Discovered Terminal Servers
Virtual Desktops

VMware Configuration

Hyper-V Configuration

App-V Configuration

> Confirm Environment to be Monitored

ox
manually entered.
From version 7.5, depending on how your is setup, the confi jon database will hold A
lrrfwmawnabomwebac(ussevvers.Inﬂls(asenlsnotnecmarvwmanualyadddmfume
web access servers. Secure gateways will still need to be added manually.
Use the tables below to provide the details for the web access servers and secure gateways that you
wish to monitor.
Once all the details have been entered as required, dick the "Discover Environment” button below to
complete the discovery process.
« Each web access server and secure gateway should have a name, a fully qualified host name
and a port number on which it is listening.
« Web access servers also require that the Web application root be defined.
© Add Web Access Server Remove Web Access Sesver| Search P
Name Host Name Port URL
There Is No Data To Display
© Add Secure Gateway | Remove Secure Gateway | Search P~
Name Host Name Port
There Is No Data To Display
Please diick on the "Discover Environment " button to discover the of the Dell k
instaliation that can be monitored. If you have already discovered your environment and want to stop
monitoring components or change from where they are monitored please dick "Next".
The process of ing your Dell rk can take several minutes.
v

Figure 38 Foglight Configuration Screen

54. Verify your broker and click Next.
55. Verify your database and click Next.

56. Click Next until the Hyper-V Configuration page is displayed. The Hyper-V hosts should have
been discovered but you must specify credentials to connect to the servers. Select the check
box to select all of the hosts and click the Credentials button. Type the credentials in the dialog
box and cllck OK. Cllck Next to continue.
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57. Click Next on the App-V Configuration page.
58. Click Finish.

Applying Foglight License

If you did not specify the Foglight license during installation, perform the following tasks to apply.

1

oUW

Log in to the vWorkspace Broker VM, start the vWorkspace Management Console, and then click
the Diagnostics & Monitoring link under vWorkspace Farm in the upper-left corner.

On the navigation panel, under Dashboards, click Administration 2> Setup & Support > Manage
Licenses to display the Manage Licenses dashboard and click Install.

In the Install License dialog box, click Browse.

In the file browser that appears, specify the location of the ASC license file.

In the Install License dialog box, click Install License.

After a few moments, the Install License dialog box closes, and the Manage Licenses dashboard
is automatically refreshed by showing the newly installed license in the list.

Installing Foglight Agent Manager

The following tasks describe the process of installing the Foglight Agent Manager component for
vWorkspace 8.0 MR1:

1.

Log in to the vWorkspace Broker VM, start the vWorkspace Management Console and click the
Diagnostics & Monitoring link under vWorkspace Farm in the upper left corner.

Go to the Components for Download dashboard (Dashboards - Administration - Cartridges
- Components for Download).

Click the download icon for the fglam-5.6.7-windows-x86_64.exe file and save the
installer to a location that is accessible to the Foglight Agent Manager VM.

Log in to Foglight Agent Manager, right-click the installer you saved, and then select Run as
Administrator.

The Agent Manager Installation and Configuration program window is displayed. Read through
the information in the Introduction and click Next.

To accept the terms of the license agreement, select the check box, and then click Next.

Select the directory where you want to install the Agent Manager and click Next. If the directory
does not exist, the installer displays appropriate message and prompts you regarding whether or
not you want the directory to be created. To create the directory, click Yes.

On the Host Display Name page, you can configure the host name that the Agent Manager uses
to identify itself. This is also the name under which the Agent Manager submits metrics to the
Management Server. By default, the Agent Manager uses the host name that is automatically
detected for the machine on which it is being installed. This host name initially appears in the
Host Display Name box. Configure the host name settings as required and click Next.

To open the Edit Server URL dialog box, click Add. Specify the host name and port (default is
8443) used by the Agent Manager to connect to the Management Server. These can be seen
from accessing the vWorkspace Management Console and clicking the Diagnostics &
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10.

11.
12.

13.

14

Monitoring link under vWorkspace Farm in the upper left corner. After you have specified the
required connection options, click OK.

To test the connection between the Agent Manager and the Management Server, click Test. A
URL for which the connection has not been tested appears next to an orange-colored
exclamation mark icon. URLs that fail the connectivity test displays a red-colored x icon.
When you complete adding Management Server URLs, click Next.

On the Windows Service page, leave the check box selected (the default setting) to install the
Agent Manager as a Windows service and have it start automatically when Windows starts. The
Agent Manager also starts automatically when the installation is complete. Click Next.

On the next page, leave the box blank for migrating agents and click Next.

. Click Finish to complete the installation.

The following tasks describe the process of installing the Foglight Agent Manager component for
vWorkspace 8.5 and later:

O N U WD

[
o

11.
12.
13.

Log in to the vWorkspace Foglight for Virtual Desktops VM.
Access the vWorkspace setup files (go to file share, copy locally, insert DVD, download, etc.).
Right-click the start.exe file and run as administrator.
Click the Install button.
Click Yes in the .NET Framework dialog box, and then click Next.
Accept the license agreement and click Next.
Enter your user name and organization information and click Next.
Select the Advanced setup type and click Next.
Select only Monitoring and Diagnostics Agent Manager Role and click Next.
. Type the Foglight credentials, type 8080 for the HTTP port, type 1 for the number of instances
and click Next.
Click Finish to complete the installation.
Click No when prompted to view a Web site with a list of hotfixes.
Click Yes to restart and complete the installation.
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Configuring SCVMM

The following sections describe the tasks that must be completed to configure SCVYMM for integration
with the Nutanix cluster and vWorkspace broker.

NOTE: SCVMM is required only when the hypervisor is Hyper-V.

Run As Account

Log in to the VMM host and start the Virtual Machine Manager Console and do the following:

> wn e

Click Settings in the lower right pane of the console.

Click the Create Run As Account button from the Home menu.
Type a name and description.
For user name and password, type the previously created AD account information (refer to the

“System Requirements” section of this guide).

Make sure Validate domain credentials is selected and click OK.
6. To verify that the account has been added, click the arrow next to Security to expose Run As

Accounts. Click Run As Accounts and now you can see the newly added account in the left

pane.

Performance Tuning
We recommend making the following registry changes on the SCVMM VM:

Name

Type

Registry Location

Recommended
Value

IndigoSendTimeout

DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mic
rosoft\Microsoft System Center Virtual
Machine Manager Server\Settings

300

VHDMountTimeoutSeconds

DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mic
rosoft\Microsoft System Center Virtual
Machine Manager Server\Settings

3600

HostUpdatelnterval

DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mic
rosoft\Microsoft System Center Virtual
Machine Manager Server\Settings

7200

VMUpdatelnterval

DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mic
rosoft\Microsoft System Center Virtual
Machine Manager Server\Settings

7200

TaskGC

DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mic
rosoft\Microsoft System Center Virtual
Machine Manager Server\Settings\Sql
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After changing the registry settings, reset the VMM service. For explanations and more information about
System Center performance planning, refer to the article:
http://social.technet.microsoft.com/wiki/contents/articles/18059.planning-capacity-and-performance-

for-system-center-2012.aspx

Integrating SCVMM, Nutanix, and Microsoft Failover Cluster

The Nutanix CVMs contain a script that creates a Microsoft Failover Cluster using the cluster nodes and
add the cluster along with file share storage to SCVMM.

1.
2.

W

10.
11.

12.

13.
14.

15.

Log in to the host running the SCVMM server and start PowerShell.
Allow the host to access unsigned storage by running the following command.
Set-SMBClientConfiguration -RequireSecuritySignature $False -Force

Log in to any Controller VM in the cluster with SSH by using the cluster IP.
Verify that all services are running on all Controller VMs by running the following comand.
nutanix@cvm$ cluster status

If the cluster is running properly, the output displays UP for the various components on the
nodes.

Run the setup hyperv.py script with setup_scvmm as the parameter from the Nutanix CYM
prompt:

nutanix@cvm$ setup hyperv.py setup scvmm

The utility prompts for the necessary parameters and attempts to create a Microsoft Failover
Cluster using the Nutanix hosts, if one has not already been created.

When prompted, type a name for the Hyper-V failover cluster (this is the Microsoft failover
cluster name and is different from the Nutanix cluster name).

Type the domain account username that has administrator access to the hosts. This username
must include the fully-qualified domain hame. For example,
DCO1.EXAMPLE.COM\Administrator. Enter password when prompted.

Type the SCVMM server name. The name must resolve to an IP address.

Type the SCVMM user name and password if they are different from the domain account.
Otherwise, press Enter to use the domain account.

Type an IP address for the Hyper-V failover cluster. This address is for the cluster of Hyper-V
hosts currently being configured. It must be unique, different from the cluster external IP
address, and from all other IP addresses assigned to hosts and Controller VMs. It must be in the
same network range as the Hyper-V hosts.

Script output displays several tasks being run with a status Done when completed.

When prompted, we recommend to add a library share for VMM. Provide the desired name
when prompted. The library share is displayed as another container in the Nutanix GUI where
you can adjust the space if required.

Setup is now completed with the Microsoft Failover Cluster created and added to your SCVMM
configuration. To verify, go to Server Manager on any of the cluster hosts and click Tools =
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Failover Cluster Manager. You can also verify by accessing the VMM console, select Fabric, and
then click Servers.

Placement Paths on Hosts in SCVMM

1. Inthe VMM console, select Fabric in the bottom left pane, and then click Servers.
2. Expand the All Hosts folder under Servers to view the Microsoft Failover Cluster that you
previously added. Click the Microsoft Failover Cluster object.

Fabric < Hosts (3)
4 29 Servers = |
4 7] All Hosts Name Host Status ~ | Role Job Status =
@ HV-BENSEN-MFC # HV-BENSEN-01.05PREY.COM oK Host Completed
» B, Infrastructure ' HY-BENSEN-03.0SPREY.COM oK Host Completed
4 i Networking || 1 HV-BENSEN-02.0SPREY.COM oK Host Completed

Figure 40 Microsoft Failover Cluster

3. Under the Hosts pane, right-click the first host and select Properties.

i Cluster Tools | Server Tools Administrator - BENSEN-vWS-VMM.OSPREY.COM - Virtual Ma
[ =R Home Folder Haost Cluster Host
@ [#] Shut Down Power On  jp Start Maintenance Mode Move to Host Group =% Remove Cluster Node
) . ] Qg(- Restart \(ﬂ' Power Off _. Stop Maintenance Mode
Refresh Rﬁr:qe::h}:;tsual &) Reset @View Status [P Run Script Command
Host Cluster
Fabric < Hosts (3)
- ﬂ Servers . |
4 7] All Hosts Name Host Status ~ | Role Job Status =
@ HV-BENSEN-MFC }  HV-BENSEN-01.05PREY.COM Completed
4 j.m. Infrastructure ¥ HV-BENSEN-03.0SPREY.COM 0K Host Completed
4 _i Networking = ¥ HV-BENSEN-02.0SPREY.COM 0K Host Completed
41 Logical Networks

Figure 41 Host Properties

4. In the host Properties window, click Placement Paths in the left pane.

51

(
Wyse Datacenter Appliance XC for vWorkspace r%f"‘)ﬂ U"

o —

\\\%\ > //A



5. In the Specify the default parent disk paths to be used for the virtual machines section, remove
all existing paths (if present) by selecting them, and then clicking Remove. When finished, click

OK.
= HY-BENSEN-01.05PREY.COM Properties -
General Placement Paths
Status Specify default virtual machine paths to be used during virtual machine placement:
Hardware
Remove
Host Access

Virtual Machine Paths
Reserves
Storage

Virtual Switches Specify the default parent disk paths to be used for the virtual machines:

L . WWhv-bensen.osprey.comids_mgmt
Migration Settings

Placement Paths

Servicing Windows

WWhv-bensen.osprey.com\ds_compute

Custom Properties

OK | | Cancel

Figure 42 Placement Paths

6. Repeat tasks 3-5 for all hosts in the cluster.
7. Right-click the MS Failover Cluster and select Properties.
8. In the Properties window, click File Share Storage in the left pane.
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9. By default, the containers you created in the Configuring Nutanix Storage Pool and Containers

section will be present. Select each file share path listed and click Remove to remove file shares.

5 HY-EENSEN-MFC.OSPREY.COM Properties -
General File Share Storage
Status The following file shares will be available as storage locations for VMs deployed to nodes in this cluster:
File Share Path Access Sta... | Classification Free Space | Total Capa...

Available Storage

W\hv-bensen.OSPREY.COM\ds mgmt ) Remote Storage 3,897.00 GB  4,307.69 GB

File Share Storage Why-bensen.OSPREY.COM\d:_compute 'Q‘ Remote Storage 5,308.60 GE  5738.20 GB
Shared Volumes
Virtual Switches
Custom Properties
Repair Add... | ‘ Remove |

Use an existing Run As account to access file shares for ongoing operations,

RunAsaccount:  OSPREY-scvmm_RunAs

View Script OK H Cancel |

Figure 43 Remove File Shares

10. Also, by default, the file share path will contain the FQDN of the host. Because of an apparent

bug in SCVMM, you must specify a placement path on each host that contains only the host
name in order for ODX Fast File Copy to work properly. If you specify the default path using the
FQDN, SCVMM will fall back to using BITS for copying the virtual disk files which will result in
much slower provisioning times. To specify a placement path that contains only the host name
in the UNC path, you must first add it to the file share storage paths for the MS Failover Cluster.
Click the Add button on the File Share Storage page.

11. In the Add File Share window, type the path to your compute container but do not use the

FQDN for the host—only use the host name.
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Specify a valid SMB share path to use for VM

deployment

File share path: I\\h\'—bensen\ds_camputel | |v|

To register a file share te this cluster, select a managed file share from the
list er enter the UNC path for an unmanaged file share,

For managed shares, VMM grants file share access to the Active Directory
computer account for the virtualization cluster and the VMM cluster
management account. For unmanaged file shares, ensure that the Active
Directory computer account for the virtualization cluster and the VMM
cluster management account have access to the file share,

To bring a file share into management: in the VMM console, open the
Fabric workspace, click the Providers node, and then click "Add Storage
Device."

| ok || Cancel

Figure 44 Specify SMB Share Path

12. Click OK in the Add File Share window. The share will be listed on the File Share Storage page
of the Properties window until you click OK. After you click OK and view the properties of the
Failover Cluster again. The original FQDN path will be listed. This is the expected behavior.

13. Click OK to close the Properties window. Right-click the Failover Cluster and select Refresh.

14. In the VMM console, under the Hosts pane, right-click the first host and select Propertles

H Cluster Tools | Server Tools Ad \dministrator - rr_‘\E:ﬂ_—‘ -vWA h‘*&h‘ﬂT"m flq:]—t-
[ =R Home Folder Haost Cluster | Host
G m Shut Down  ({({) Power On ,%b Start Maintenance Made Move to Host Group -ﬂ Remove Cluster Node
] 2% Restart m Power Off g Stop Maintenance Mode
Refresh Rﬂr:-q?:h}:gtsual £ Reset @ view Status [ Run Script Command
Host Cluster
Fabric 4 Hosts (3)
4 32 Servers = |
4[] Al Hosts Name Host Status ~ | Role Job Status =
. HV-BENSEN-MFC ") HV-BEMSEN-01.QSPREY.COM Completed
» B Infrastructure ' HV-BENSEN-03.0SPREY.COM oK Hast Completed
4 _& Networking = ¥ HV-BENSEN-0Z.0OSPREY.COM QK Host Completed
1 Logical Networks

Figure 45 Hosts Properties
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15. In the host Properties window, click Placement Paths in the left pane.
The Specify the default parent disk paths to be used for the virtual machines section will now
display the UNC share that contains the host name instead of the FQDN.

= HY-BENSEN-01.05PREY.COM Properties -
General Placement Paths
Status Specify default virtual machine paths to be used during virtual machine placement:
Hardware
Remove
Host Access

Virtual Machine Paths
Reserves
Storage

Virtual Switches Specify the default parent disk paths to be used for the virtual machines:

| Y\hv-bensen\ds_compute

Migraticn Settings

Placement Paths

Servicing Windows

Custom Properties

Figure 46 Specify Placement Paths
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16. If any other file paths are listed, select them and click Remove. Only the file path to your

compute container that is not using the FQDN of your host must be present.

Ll HY-BENSEN-03.0SPREY.COM Properties -
General Placement Paths
Status Specify default virtual machine paths to be used during virtual machine placement:
Hardware =
Remove
Host Access
Virtual Machine Paths
Reserves
Storage
Virtual Switches Specify the default parent disk paths to be used for the virtual machines:
WWhy-bensen'ds_compute Add...

Migraticn Settings

\ihv-bensen.osprey.combds_mgmt II

Wihv-bensen.osprey.com'ds_compute
Placement Paths

Servicing Windows

Custom Properties

Figure 47 Remove File Paths

17. Click OK. Repeat tasks 14—-17 for all hosts in the cluster.

NOTE:

If the FQDN of the host is used in the placement path, SCVMM will use BITS instead of Fast File

Copy to copy the virtual disk files resulting in much slower provisioning times. Also, if more than one
placement path is specified, SCVMM wiill distribute the virtual disk files across the multiple locations.

6.4 Integrating vWorkspace with SCVMM

Log in to the VWS connection broker VM and start the Management Console.

1.

In the left pane, click Locations under vWorkspace Farm until SCVMM is displayed under
Virtualization Hosts.

Right-click SCVMM and select Add host groups or clusters.

Click Next on the Import Host Groups & Clusters page. Click the Edit Virtualization Servers
button.

Click the New button. On the Welcome screen, click Next.

Type a name for the SCVMM server (this can be the actual host name or whatever you want as it
only applies to what is displayed in the console). Select Microsoft SCVMM as the system type
and click Next.

Type the actual host name (or IP address) of the SCVMM server along with the credentials to
access. Click the Test connection to server button to verify connectivity, and then click Next.
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On the Other Settings page, adjust the concurrency settings to 10 and click OK.

On the Management Servers window, click OK.

To select Host Groups & Clusters, click Next.

10. The SCVMM server should appear in the Host Groups & Clusters pane. Expand the SCVYMM
server until the Microsoft Failover Cluster name is displayed and click the name to select the
cluster. Click Finish.

© © N
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Configuring Microsoft Failover Cluster

Perform the following tasks to complete the configuration of the Microsoft Failover Cluster.

NOTE: Microsoft Failover Cluster is required only when the hypervisor is Hyper-V.

MS Failover Cluster Quorum
The Microsoft Failover Cluster does not use any of the host drives for its configuration. For quorum,
configure a file share witness using the ds_mgmt container.

1. Login to one of the Hyper-V hosts. In Server Manager, click Tools, and then select Failover
Cluster Manager. In Failover Cluster Manager, click the name of the cluster. Click Action on the
top menu of Failover Cluster Manager, click More Actions, and then select Configure Cluster
Quorum Settings.

On the Before You Begin window, click Next.

Select Select the quorum witness and click Next.

Select Configure a file share witness and click Next.

Type the path to your ds_mgmt share (that is \\cluster\ds mgmt) and click Next.

On the confirmation page, click Next and click Finish to complete.

o Uk W

Setting up MS Failover Cluster Network

To view the cluster network settings, expand Networks in Failover Cluster Manager.

For each network available, right-click and select Properties to change the name. In the following
example, this network is associated with the cluster VLAN and renamed it to Cluster.
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Cluster Network 1 Properties -
| General

-mif
31 Cluster Network 1

MName:

|Clusler| |
| @ Allow cluster network communication on this network |
[] Allow clients to connect through this network
) Do not allow cluster network communication on this network
Status: Up
Subnets: 192.168.25.0/24

[ ok || camce || Aoy

Figure 48 Cluster Network 1 Properties
NOTE: Clients should not be allowed to connect through the Cluster or Live Migration networks.

After configuring the properties for each of your networks, click Live Migration Settings under the Actions
pane. Specify that only the Live Migration network be used for this purpose.

7.3 Adding Management VMs as Highly Available VMs

Now that the Microsoft Failover Cluster is created, the Management VMs should be added to the cluster.
To add the existing VMs to the cluster and configure for high availability:

1. In Failover Cluster Manager, in the left pane, click the cluster name, right-click Role and select
Configure Role.

On the Before You Begin window, click Next.

Select Virtual Machine as the role and click Next.

Select all the Management VMs that you created in Section 5.

To confirm and proceed with the configuration, click Next.

A summary displays when complete. Click Finish.

o Uk W
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Configuring vCenter

The following sections describe the tasks that must be completed to configure vCenter for integration
with the Nutanix cluster and vWorkspace broker.

NOTE: vCenter is required only when the hypervisor is vSphere.

Integrating vCenter and Nutanix

The Nutanix cluster and nodes must be added to vCenter. To add the Nutanix configured ESXi hosts to
vCenter:

1. Open the vSphere Client to attach to the vCenter Server Appliance and click File > New >
Datacenter. Type a meaningful name for the datacenter.

2. Right-click the datacenter and select New Cluster. The New Cluster Wizard is displayed.

3. On the New Cluster Wizard page, type a meaningful name for the cluster in the Name box.
Refer to the Nutanix vSphere Adminstration Guide for recommended vSphere cluster settings
related to HA and DSR. Click Next.

4. Select Disable EVC for the VMWare EVC and click Next.

5. On the VM Swapfile Location page, select Store the swapfile in the same directory as the
virtual machine (recommended) and click Next.

6. Click Finish on the Ready to Complete page to complete the cluster setup.

7. Right-click the newly created cluster and select Add Host. Type the ESXi host FQDN or IP
address and the ESXi host user name and password in the Add Host wizard, and then click Next.

8. Review the host summary in the Add Host wizard and click Next.

9. On the Assign License page, assign a license key using an existing or new license key and click
Next.

10. On the Configure Lockdown Mode page, do not select the Enable Lockdown mode check box
as it is not supported. Click Next.

11. Click Finish to add the ESXi host to the cluster.

12. Repeat tasks 7-11 to add all Nutanix configured ESXi hosts to the cluster in vCenter.

Integrating vWorkspace with vCenter

Log in to the vWS connection broker VM and start the Management Console.

1. Inthe left pane, click Locations under vWorkspace Farm until VMware is displayed under
Virtualization Hosts.

2. Right-click VMware and select Add datacenters.

Click Next on the Welcome page of the Datacenter Wzard.

4. Click the Edit Virtualization Servers button. On the Welcome to the vCenter Server Wizard
page, click Next.

W

Wyse Datacenter Appliance XC for vWorkspace



5. Type a name for the vCenter server (this can be the actual host name or whatever you want as it
applies only to what is displayed in the console). Select VMware vCenter Server as the system
type and click Next.

6. Type the vCenter server name along with the credentials to access. Click the Test connection to
server button to verify connectivity, and then click Next.

7. On the Other Settings page, click Finish.

On the Datacenter Wizard page, click Next.

9. On the Select Datacenters page, select the name of the datacenter that you created in the
previous section. Click Finish.

®
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Floating vs Dedicated Management

If your cluster is running more than 1000 desktops or contains 10 or more nodes, we recommend that the
management VMs reside on dedicated hosts (Dedicated Management model). For environments smaller
than this, the management VMs will be spread evenly across the cluster nodes (Floating Management
model). For example, if your cluster consists of three Hyper-V nodes, two of the management VMs will be
configured to run on each node.

To configure the management VMs in a Floating Management model when using Hyper-V as the

hypervisor:

1. In Failover Cluster Manager, click Roles in the left pane, right-click the broker VM, and then
select Properties.

2. Click to select the first node as the Preferred Owner and select High as the priority from the
Priority drop-down menu. Click OK.

3. Right-click the broker VM again and select Move - Quick Migration 2 Select Node. Click the
name of the first node to select and click OK.

4. Right-click the Web Access VM and select Properties. Also select the first node as the preferred
owner and change the priority to High. Click OK.

5. Right-click the Web Access VM again and click Move 2 Quick Migration = Select Node. Click
the name of the first node to select and click OK

6. Right-click the SQL VM and select Properties. Select the second node as the preferred owner
and change the priority to High. Click OK.

7. Right-click the SQL VM again and click Move = Quick Migration > Select Node. Click the
name of the second node to select and click OK

8. Right-click the Foglight VM and select Properties. Also, select the second node as the preferred
owner and change the priority to High. Click OK.

9. Right-click the Foglight VM again and click Move - Quick Migration 2> Select Node. Click the
name of the second node to select and click OK

10. Right-click the SCVMM VM and select Properties. Select the third node as the preferred owner
and change the priority to High. Click OK.

11. Right-click the SCVMM VM again and click Move - Quick Migration > Select Node. Click the
name of the third node to select and click OK.

12. Right-click the Foglight Agent Manager VM and select Properties. Also select the third node as
the preferred owner and change the priority to High. Click OK

13. Right-click the Foglight Agent Manager VM again and click Move - Quick Migration > Select

Node. Click on the hame of the third node to select and click OK
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Deploying Virtual Desktops

The process for deploying virtual desktops consists of creating a desktop template, importing the template

to SCVMM or vCenter (depending on the hypervisor used), and adding the template to a provisioning
group in vWorkspace. The vWorkspace broker will create the specified number of desktops from the
template to be used in the virtual desktop deployment.

To provision virtual desktops, perform the following tasks.

10.1  Desktop Template (Gold Image) Setup
10.1.1  Template VM Creation
The tables here summarize the desktop template configurations used by Dell during solution testing.
Startup Dynamic Memory OS vDisk
Solution
Platform s vCPU RAM NIC Size
(GB) Min|Max Buffer |Weight (GB) Location
Entry Platform | Win 8.1 Ent. x32 1 1 512MBJ2GB | 20% Med 1 25 | ds_compute
Mid Platform | Win 8.1 Ent. x32 2 1 512MBJ|3GB | 20% Med 1 25 | ds_compute
High Platform | Win 8.1 Ent. x64 2 1 1GB|4GB 20% Med 1 25 | ds_compute

63

Hyper-V Desktop VM Example Configuration Table

) OS vDisk
Patorm | 05| VPV | gmy NS T
(GB) Location
Entry Platform | Win 8.1 Ent. x32 1 2 1 25 | ds_compute
Mid Platform | Win 8.1 Ent. x32 2 3 1 25 | ds_compute
High Platform | Win 8.1 Ent. x64 2 4 1 25 | ds_compute

vSphere Desktop VM Example Configuration Table

The desktop template VM can be created by using any appropriate vCPU and memory allocations.
However, we recommend completing the following tasks to create the VHDX file for optimal use with
vWorkspace and Hyper-V.
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NOTE: Solution is provided on the basis of using full clones for persistence (Standard provisioning) and
recommended disk format is VHDX. If using linked clones and rapid provisioning is necessary, you must
use VHD format with this version of vWorkspace.

1. Open PowerShell and go to the path where you want the template VM to be stored.

2. Run the following command to create a VHDX file for the template VM using the following
necessary specifications. Replace “"VMName.vhdx” with the full path and name for the VHDX file.
new-vhd -path "VMName.vhdx" -dynamic -SizeBytes 25GB -
PhysicalSectorSizeBytes 512 -LogicalSectorSizeBytes 512 -BlockSizeBytes
2MB

3. Create a desktop VM using the desired vCPUs and vRAM allocation and attach the newly created
VHDX file to the VM.

To create a desktop VM template for Hyper-V configuration:

Log in to any of the hosts in the cluster and start Server Manager.

In Server Manager, from the Tools menu, select Hyper-V-Manager.

In Hyper-V Manager, connect to the local server.

Right-click the name of the local server in the left pane and click New - Virtual Machine.

On the Specify Name and Location page of the New Virtual Machine wizard, type the name and

location of the VM. The location is the Nutanix SMB share for your compute container (for

example, \\nutanix-cluster\ds_compute).

On the Specify Generation page, specify Generation 1 and click Next.

7. On the Assign Memory page, type the amount of startup memory according to your needs
(optionally, type the setting from the Hyper-V Desktop VM Example Configuration table). Click
the Use Dynamic Memory for this virtual machine check box, and then click Next.

8. On the Configure Networking page, select the “ExternalSwitch” vSwitch. Click Next.

9. On the Connect Virtual Hard Disk page, select the Use an existing virtual hard disk option.
Type or browse to the location of the virtual disk you created using the VHDX Creation Steps for
Hyper-V. Click Next.

10. On the Installation Options page, select the Install an operating system later option. Click
Finish.

11. After creating the VM, right-click the VM in the Virtual Machines pane and select Settings.

12. Click Memory and adjust the settings according to your requirements (optionally, type the
settings from the Hyper-V Desktop VM Example Configuration table).

13. In the VM settings, click Network Adapter in the Hardware pane, and enable virtual LAN

identification. Enter the VLAN ID for your desktop VLAN, if applicable.

ok W=

o
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10.1.5

10.1.51

10.1.5.2

Creating Desktop VMs for the vSphere hypervisor configuration

For equivalent steps to create desktop VMs for vSphere, see the vSphere Virtual Machine Administration
Guide (ESXi 5.5). For example specifications to use for the desktop VMs, refer to the vSphere Desktop VM
Example Configuration Table earlier in this guide.

NOTE: Solution is provided on the basis of using full clones for persistence (Standard provisioning) and
recommended disk format is VMDK. Ensure the Template VM is placed in the same container as the
Desktop pool (for example, ds_compute) for faster deployment.

Installing Desktop OS and Application
1. Install the appropriate Windows desktop OS using Windows 7 or later (other OSs are supported
but out of scope for this document) on the desktop template VM. Attach an .iso file to the virtual
DVD drive or use existing OS deployment applications to install the desktop OS.
2. Install all of the necessary corporate applications. For example, Microsoft Office suite.

Installing vWorkspace Agent
The Instant Provisioning and PNTools components must be installed as part of the vWorkspace agent
setup.

NOTE: Instant Provisioning and PNTools Installers are available at the following location on the
vWorkspace broker VM: C: \Program Files (x86) \Quest Software\vWorkspace

Installing Instant Provisioning
Instant provisioning services are installed on the master template, and instant provisioning is the
mechanism which customizes the VMs during the cloning process.

Right-click the InstantProvisioning.exe file and select Run as administrator.

When prompted to install .NET Framework, click Yes, and then click Next.

To acknowledge the message about installing the service to the master template, click OK.
Accept the EULA and click Next.

Type customer information and click Next.

To complete the installation, click Install, and then click Finish.

o Uk N

Installing PNTools
PNTools (Virtual Desktop Extensions) is a set of executables, libraries, and device drivers that provide
features and management functionality for managed computers in a vWorkspace infrastructure.

1. To begin installation, double-click PNTools.msi installer.
2. Click Next.
3. Accept the EULA and click Next.
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4. Select Complete installation type and click Next.
5. To complete the installation, click Install, and then click Finish.
6. To restart the system, click Yes.

Optimizing Desktop OS
vWorkspace includes an application called Desktop Optimizer that can be used to optimize desktop
settings for a VDI environment including disabling unnecessary services.

The vWorkspace Desktop Optimizer is installed with the Instant Provisioning Tools and can be opened
from C:\Program Files\Quest Software\vWorkspace\Desktop Optimizer. The application has
a list of settings or services in the left pane along with a description and reason for modifying in the right
pane.

Windows 8.x Optimization

The Desktop Optimizer tool can be used for Windows 8.x or alternatively, you can use an optimization
script from Microsoft that is available at:

http://blogs.technet.com/b/jeff_stokes/archive/2013/04/09/hot-off-the-presses-get-it-now-the-
windows-8-vdi-optimization-script-courtesy-of-pfe.aspx

A new feature in Win 8.1 is Automatic Windows Maintenance, which is a feature of the dism tool that
checks the system and application for update compatibility and file integrity. By default, the system
scheduled task runs at 1 A.M. everyday, or any time after 10 min of idle time. When the system runs, the
tiworker.exe process can consume 100 percent CPU on any recently booted desktop VMs, possibly
overloading servers.

The administrator accounts cannot change the services because the services (idle time check and
automatic check) run as a SYSTEM. You must get SYSTEM rights to disable services.

You can still run the checks manually even if the services are disabled. You must have psexec.exe
(sysinternals) on the Master Image VM to fix this problem.

The following are the three scheduled tasks that must be disabled on your desktop template.

psexec \\SERVERNAME -s schtasks /change /tn
"\Microsoft\Windows\TaskScheduler\Maintenance Configurator" /DISABLE

psexec \\SERVERNAME -s schtasks /change /tn
"\Microsoft\Windows\TaskScheduler\Idle Maintenance" /DISABLE

psexec \\SERVERNAME -s schtasks /change /tn
"\Microsoft\Windows\TaskScheduler\Regular Maintenance" /DISABLE

After the desktop template VM has been optimized, shut down the desktop VM to import the template.
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Adding Desktop Template to SCVMM

NOTE: SCVMM is only required when the hypervisor is Hyper-V.

The desktop template must first be added to SCVMM as a VM template and then imported to vWorkspace
as a template while creating a computer group.

After creating a desktop VM on one of the Hyper-V hosts, log in to the SCVMM server to add it as a
template.

1. Shut down the desktop VM that you want to use as your template before you begin.

2. Start the Virtual Machine Manager Console (the console is installed to the SCVMM VM during the

VMM installation) and click Library in the lower-left pane.

In the left pane, click Templates and right-click VM Templates. Select Create VM Template.

4. In the Select Source window, select From an existing virtual machine that is deployed on a
host, and then click Browse. Select the desktop VM that you want to use as a template and click
OK.

5. Click Next and click Yes to proceed. The source VM is destroyed on the Hyper-V host but the

settings and VHDX are imported to the SCVMM server and library.

Provide a name and optional description for the template and click Next.

Click Next on the Configure Hardware page and the Configure Operating System page.

Select the SCVMM server from the list of library servers and click Next.

To store the VHDX file, click the Browse button and select a library folder. This library folder

must be the folder that was created earlier on the Nutanix cluster. Click OK and click Next.

10. Click Create to complete the task. If job fails immediately, verify that the desktop VM was not
running. If the desktop VM was not running, shut down the desktop VM. In the Jobs window,
right-click the Create template and select restart. After creating the templates, close the Jobs
window if still open.

11. The template should now appear in the Templates pane in VMM.

12. Right-click the template and select Properties.

13. Click Hardware Configuration in the left pane and use the scroll box in the middle of the page
until you see the Advanced section.

«
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14. Click Availability under the Advanced section and select the Make this virtual machine highly
available check box. The default Medium priority is sufficient.
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Figure 49 VM Template Properties

15. Click OK to exit and save.

Adding Desktop Template to vCenter
NOTE: vCenter is required only when the hypervisor is vSphere.

The desktop template must first be added to vCenter as a VM template, and then imported to vWorkspace
as a template while creating a computer group.

Refer to the vSphere Virtual Machine Administration Guide (ESXi 5.5) for instructions about cloning a
desktop VM to a template.

Creating a Computer Group and Provisioning Desktops

A computer group in vWorkspace is used to create and maintain desktops.
To set up a computer group when using SCVMM and define its properties:

1. Start vWorkspace Management Console (by default, installed to the vWorkspace Broker VM).
Open the Computer Group wizard from Desktops node (right-click Desktops node, and then
select New Computer Group).

3. Click Next on the Welcome window of the New Computer Group wizard.
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Figure 50

4,
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vWorkspace New Computer Group Wizard

Type name of the computer group in the Group Name box on the Group Name page, and then
click Next.

Select Microsoft SCVMM on the System Type page, and then click Next.

On the Administrative Account page, type information about the domain account that will be
used as an administrative account. Select the password check box to validate the credentials.
Click Next.

On the Auto-Size page, you can allow the group to increase the number of desktops based on
demand if required. Click Next to retain the default of controlling the number of desktops.

Click Next on the Enable/Disable page.

On the Client Assignment page, select Persistent and User to create persistent desktops
assigned to user accounts. Otherwise, select the appropriate combination for your configuration
and click Next.

Click Next on the Access Timetable page unless you want to limit the hours of access.

Select Use the default load balancing rule on the Load Balancing page and click Next.

Select the appropriate privileges on the User Privileges page and click Next.

Click Next on the next two pages to accept the default settings.

Select the preferred logoff action on the Logoff Action page. For persistent desktops, the typical
choice is to do nothing. Click Next.
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15. Click Next on the Session Protocol page for RDP protocol.

NOTE: This page does not appear in vWorkspace 8.5 and later.

16. Click Next to accept defaults on the Experience Optimization page.

17. Enable support for EOP Audio on the EOP Audio page if necessary and click Next.

18. Click Next on the Task Automation page.

19. Click Next on the Permissions page.

20. Select Create new computers from a master template and click Finish. The Add Computers
wizard is displayed.

21. Click Next on the Welcome page for the Add Computers wizard.

22. Specify the number of computers you want to create for the group on the Number of
Computers to Create page and click Next.

23. For persistent desktops, select Standard on the Clone Method page and click Next.

24. On the Host Groups & Clusters page, select your VMM server from the SCVMM server drop-
down menu. The Failover Cluster should appear in the Host Groups & Clusters box. Select the
cluster and click Next.

25. Click OK to acknowledge the information window.

26. On the Template page, click the Import button to import the VM template from SCVMM. Click
OK to acknowledge the information box. Click the name of the template and click Next.

27. On the Naming Conventions page, specify the base name and values and click Next.

28. On the Customize Operating System page, click the New button. The New Operating System
Customizations is displayed.

29. Click Next on the Welcome page for the New Operating System Customizations wizard.

30. On the Name page, type a name for the customization object and click Next.

31. Click through the customization pages and select the appropriate settings for your environment.

32. After clicking Finish on the New Operating System Customization wizard, you will be returned
to the Add Computers wizard.

NOTE: After creating a customization object, it can be re-used for additional groups.

33. The customization object is displayed in the window on the Customize Operating System page.
Click the name to select it and click Next.

34. On the Configure Hardware page, the video adapter, memory, and network adapter settings can
be adjusted. By default, the settings associated with the SCVMM VM template are used. Click the
Network Adapter tab to specify the VLAN ID for your virtual desktops. Click Next.

35. In vWorkspace 8.0 MR1, an Object variable or With block variable error message is displayed
indicating a known bug. Click No to ignore.

36. On the Options page, click Next to create the desktops

37. On the Finish page, a list of computer names that will be created is displayed. Click Finish to
provision the desktops.

To setup a computer group when using vCenter and define its properties:
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Refer to the vWorkspace Administration Guide for the equivalent steps for provisioning persistent desktops
using standard provisioning.
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Deploying Shared Sessions (RDSH)

The process for deploying RDSH is similar to deploying virtual desktops. A template VM for RDSH is first
created and then imported to SCVMM or vCenter (depending on the hypervisor used) and added to a
provisioning group in vWorkspace. The vWorkspace broker will create the specified number of RDSH VMs
from the template to be used in the shared session deployment.

To provision shared sessions, perform the following tasks.

11.1  Setting up Shared Session (RDSH)

11.1.1  Creating RDSH VM Template

72

The tables here summarize the RDSH VM configuration.

VMs Startup Dynamic Memory OS vDisk
Solution Platform per | vCPU | RAM NIC Size
host (GB) Min|Max | Buffer | Weight (GB) Location
Entry Platform 6 3 16 512MB|32GB | 20% Med 1 80 ds_rdsh
Mid Platform 6 4 16 512MB|32GB | 20% Med 1 80 | ds_rdsh
High Platform 6 5 16 512MB|32GB | 20% Med 1 80 | ds_rdsh
Hyper-V Shared Session VM Sizing Table
OS vDisk
. VMs RAM
Solution Platform per | vCPU NIC .
host et S Location
(GB)

Entry Platform 6 3 32 1 80 ds_rdsh

Mid Platform 6 4 32 1 80 ds_rdsh

High Platform 6 5 32 1 80 ds_ rdsh

vSphere Shared Session VM Sizing Table

To create an RDSH VM Template for Hyper-V configuration:

Log in to any of the hosts in the cluster and start Server Manager.

In Server Manager, from the Tools menu, select Hyper-V-Manager.

In Hyper-V Manager, connect to the local server.

Right-click the name of the local server in the left pane and select New > Virtual Machine.

AW e
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10.

11.

12.

13.

14.

15.

16.

On the Specify Name and Location page of the New Virtual Machine wizard, type the name and
location of the VM. The location is the Nutanix SMB share for your RDSH container (for example,
\\nutanix-cluster\ds_rdsh).

On the Specify Generation page, specify Generation 2 and click Next.

On the Assign Memory page, type the amount of startup memory according to the Hyper-V
Shared Session VM Sizing table and select the Use Dynamic Memory for this virtual machine
check box. Click Next.

On the Configure Networking page, select the “ExternalSwitch” vSwitch. Click Next.

On the Connect Virtual Hard Disk page, select the option to Create a virtual hard disk. Type the
name, location, and size of the virtual disk. The location will be the Nutanix SMB share for your
RDSH container. Recommended sizes are in the Hyper-V Shared Session VM Sizing table. Click
Next.

On the Installation Options page, select Install an operating system later. Click Finish.

After creating the VM, right-click the VM in the Virtual Machines pane and select Settings.

Click Memory and adjust the settings to match those in the Hyper-V Shared Session VM Sizing
table.

In the VM settings, click Network Adapter in the hardware pane and enable virtual LAN
identification. Enter the VLAN ID for your management VLAN, if applicable.

Windows Server 2012 R2 must be installed to the VM. To install Windows Server 2012 R2, attach
an .iso file to the virtual DVD drive or by using existing OS deployment tools.

After installing the OS and applying your Windows license key, configure an IP address for the
VM (DHCP is acceptable).

Change the computer name to your required host name and join the VM to your domain.
Remember that this source VM is destroyed once imported in to SCVMM.

Installing RDSH Role and User Applications
These tasks will be performed after logging in to the RDSH VM.

Remote Desktop Session Host Role

O© 0N WN

Log in to the RDSH VM, open Server Manager, click Manage and select Add Roles and Features.
Click Next on the Before you begin page.

On the Installation Type page, select Role-base or feature-based installation and click Next.
Select your RDSH server from the pool and click Next.

Select Remote Desktop Services on the Server Roles page and click Next.

Click Next until the Role Services page opens and select Remote Desktop Session Host.

In the dialog box, make sure Include management tools is selected and click Add Features.
Select Restart the destination server, click Yes to restart, and then click Install.

After the VM restarts and the RDSH configuration has successfully completed, click Close.
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Application Installation

The RD Session Hosts require the user software installed locally as this is the OS that it is being used by the
users connected using the Remote Desktop Session. The requirement is customer specific but includes
your standard office type applications.

vWorkspace Terminal Server Role

1. Access the vWorkspace setup files (go to file share, copy locally, insert DVD, download, etc.).
2. Right-click start.exe and run as administrator.

3. Click the Install button to begin.

4. Click Yes in the .NET Framework dialog box and click Next to continue.

5. Accept the license agreement and click Next.

6. Type your user name and organization information and click Next.

7. Select Advanced setup type and click Next.

8. Select “Terminal Server/RD Session Host Role" and click Next.

9. Click OK to acknowledge the terminal server information message.

10. Click Yes to enable RDP-TCP audio redirection.

11. Select “Connect to an existing database” and click Next.

12. Specify your database configuration information using the SQL server name created during the

SQL installation. The database name, viWWorkspace login, and password must match with what
was previously used when configuring the vWorkspace Broker in section 5. Click Next.
13. Click Finish and select Yes to restart.

Apply the following vWorkspace hotfixes:

e 318403
e 331043

Instant Provisioning Service

NOTE: Instant Provisioning installer is available in the following location on the vWorkspace broker VM:
“C:\Program Files(x86)\Quest Software\vWorkspace".

Right-click InstantProvisioning.exe and select Run as administrator.

Click Yes to install .NET Framework and click Next.

Click OK to acknowledge the message about installing the service to the master template.
Accept the EULA and click Next.

Enter customer information and click Next.

Click Install and click Finish to complete the installation.

6. Shut down the RDSH VM to allow it to be imported to SCVMM.

ok =

74 Wyse Datacenter Appliance XC for vWorkspace



11.2 Adding RDSH Template to SCVMM

NOTE: SCVMM is required only when the hypervisor is Hyper-V.

The RDSH template must first be added to SCVMM as a VM template and then imported to vWorkspace as
a template while creating a Session Host provisioning group.

After creating a RDSH VM on one of the Hyper-V hosts, log in to the SCVYMM server to add it as a template.

1. Shut down the RDSH VM that you want to use as your template before you begin.

Start the Virtual Machine Manager Console (the console is installed to the SCVMM VM during the
VMM installation) and click Library in the lower left pane.

3. Click the arrow next to Templates in the upper left pane to expose menu options and right-click
VM Templates. Select Create VM Template.

4. In the Select Source window, select From an existing virtual machine that is deployed on a
host and click Browse. Select the RDSH VM that you want to use as a template and click OK.

5. Click Next and click Yes to proceed. The source VM is destroyed on the Hyper-V host but the

settings and VHDX are imported to the SCVMM server and library.

Provide a name and optional description for the template and click Next.

Click Next on the configure hardware page and the configure operating system page.

Select the SCVMM server from the list of library servers and click Next.

Click the Browse button and select the library folder that was created earlier on the Nutanix

cluster. Click OK and click Next.

10. Click Create to complete the task. If the job fails immediately, verify that the desktop VM is not
running. Shut down the desktop VM if it is running. In the Jobs window, right-click the Create
template job and select Restart. After the job completes, close the Jobs window

11. The template should now appear in the Templates pane in VMM.

12. Right-click the template and select Properties.

13. Click Hardware Configuration in the left pane and use the scroll bar in the middle of the page
until you see the Advanced section.

14. Click Availability under the Advanced section and select the Make this virtual machine highly
available check box. The default Medium priority is sufficient.

© o N
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Figure 51 VM Template Properties

15. Click OK to exit and save.

11.3  Adding RDSH Template to vCenter

NOTE: vCenter is only required when the hypervisor is vSphere.

The RDSH template must first be added to vCenter as a VM template, and then imported to vWorkspace as
a template while creating a Session Host provisioning group.

Refer to the vSphere Virtual Machine Administration Guide (ESXi 5.5) for steps on cloning a RDSH VM to a
template.

11.4  Creating RDSH Computer Group

A RDSH computer group in vWorkspace is used to provision and maintain RDSH servers.
To setup a RDSH computer group when using SCVMM and define its properties:

1. Start vWorkspace Management Console (by default, installed on the vWorkspace Broker VM).

2. Inthe vWorkspace Management Console, navigate to Provisioning (Location - Session Hosts
- Provisioning). Right-click Provisioning and then click New Computer Group. The New
Computer Group wizard is displayed.

3. Click Next on the Welcome to the Computer Group Wizard page.

4. Type name of the computer group in the Group Name box on the Group Name page, and then
click Next.

5. Select Microsoft SCVMM on the System Type page, and then click Next.
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11.

12.
13.
14.

15.
16.

17.

18.
19.
20.
21

22.

On the Administrative Account page, type information about the domain account that will be
used as an administrative account. Select the password check box to validate the credentials.
Click Next.

Click Next on the Task Automation page.

Click Next on the Permissions page.

. On the Finish page, select Create new computers from a master template check box, and then

click Finish. The Add Computers wizard is displayed.

Click Next on the Welcome page for the Add Computers wizard.

On the Number of Computers to Create page, type the number of RDSH computers to be
created from the template, and then click Next.

Select Standard on the Clone Method page and click Next.

On the Host Groups & Clusters page, select your VMM server from the SCVMM server drop-
down menu. The Failover Cluster should appear in the Host Groups & Clusters box. Select the
cluster and click Next.

Click OK to acknowledge the information box.

On the Template page, click the Import button to import the RDSH VM template from SCVMM.
Click OK to acknowledge the information box. Click the name of the template and click Next.
On the Naming Conventions page, specify the base name and values and click Next.

On the Customize Operating System page, click the New button. The New Operating System
Customizations wizard appears.

Click Next on the Welcome page for the New Operating System Customizations wizard.

On the Name page, type a name for the customization object, and then click Next.

Complete the on-screen instructions on the customization pages and select the appropriate
settings for your environment.

After clicking Finish on the New Operating System Customization wizard, you will be returned
to the Add Computers wizard.

NOTE: After creating a customization object, it can be reused for additional groups.

23.

24.

25.

26.
27.

The customization object is displayed in the window on the Customize Operating System page.
Click the name to select customization object and click Next.

On the Configure Hardware page, the video adapter, memory, and network adapter settings can
be adjusted. By default, the settings associated with the SCVMM VM template are used. Click the
Network Adapter tab to specify the VLAN ID for your RDSH VMs, if necessary. Click Next.

In vWorkspace 8.0 MR1, an Object variable or With block variable error message is displayed
indicating a known bug. Click No to ignore.

On the Options page, select Now and click Next to create the RDSH server VMs.

On the Finish page, a list of computer names that will be created is displayed. Click Finish to
provision the RDSH servers.

To setup a RDSH computer group when using vCenter and define its properties:

Refer to the viWorkspace Administration Guide for the equivalent steps for provisioning RDSH with VMware

vCenter.
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Using the VDI Environment

To connect to the provisioned desktops or shared sessions, you must first create a Managed Application,
publish it to the corresponding desktop computer group or RDSH hosts, and assign it to the entitled users
or user groups. You must then allow access by using web browsers or installed client or both.

Creating Managed Application and Assigning Users and Groups

vWorkspace allows for the use of virtualized applications in addition to virtualized desktops and share

sessions.

The object that allows access to these applications and desktops is known as a Managed

Application. This section describes how to create a Managed Application for accessing desktops (full
clone virtual desktops or shared sessions) and how to grant access to the assigned users or groups.

You must have already completed the tasks to create a Desktop Computer Group or RDSH Computer
Group before proceeding.

1.
2.

W

10.

11.
12.

13.
14.
15.
16.

Start the vWorkspace Management Console (by default installed to the vWorkspace Broker VM).
Right-click Managed Applications under vWorkspace Farm and select New Managed
Application.

Click Next on the Welcome page.

On the Application Name page, type a name for the application you want to publish. This name
will be displayed in the vWorkspace Management Console, and in the client and web access
page. Click Next.

Select Desktop on the Application Type page and click Next.

On the Publishing page, select Session Host(s) if using RDSH and place a checkmark next to
Session Hosts to use all RDSH VMs. [f using desktops, select Managed Computer Group, click
the plus (+) icon next to Desktops, and select the name of your desktop computer group. Click
Next.

On the Display Name page, type a display name for the application and click Next. This is
optional.

Select a display icon on the Icon page and click Next.

Select the appropriate option (Desktop, Start Menu, Start Menu \Programs) for clients using
AppPortal in desktop integrated mode on the Desktop Integration page, and then click Next. It
is not necessary to select an option if you are not using desktop integrated mode.

Select the appropriate option on the EOP Graphics Acceleration page and click Next. Refer to
the vWorkspace Administration Guide to determine if EOP Graphics Acceleration is appropriate
for your environment.

Click Enabled on the Enable/Disable page and click Next.

On the Load Balancing page, select Use the default load balancing rule (only applies to RDSH)
and click Next.

Click Next on Application Restrictions page (only applies to RDSH).

On the Virtual IP page, do not enable any features (only applies to RDSH). Click Next.

On the Target Assignments page, click the plus (+) icon to open the Select Targets window.

In the Select Targets window, click the plus (+) icon to add targets from the domain users and
groups. Add the required domain user or group and click OK.
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17.

18.
19.
20.

After clicking OK on the Select Targets window, the Select Folder(s) window is displayed. Select
the desired folder location and click OK to proceed

Repeat the tasks 16-17 to add more users or groups. When finished, click OK.

On the Target Assignments page, click Next.

On the Permissions page, adjust permissions as necessary. Permissions here are for the group
that has access to modify the Managed Application. Click Finish.

Connecting to vWorkspace

Configuring Web Access and Secure Gateway

The Web Access and Secure Gateway components allow users to connect to desktops and shared

sessions using a web browser.

The configuration for the Web Access component is performed from the vWorkspace Management

Console.

Log in to a computer that has the console installed (for example, the vWorkspace broker VM) and

perform the following tasks:

1
2
3.
4
5

Start the vWorkspace Management Console.

In the upper-left pane of the console, under vWorkspace Farm, click Web Access.

In the right pane, click Actions and select New website.

Click Next on the Welcome page.
Type the name for the Web access site (the friendly name used during the installation) and the
URL which is in the form of "http://WebAccessVMName/WebAccessVirtualDirectory”. If unsure,
click the Import button, type http://WebAccessVMName in the address bar, and then click OK.

Default Rule

Custom Rules

Secure Gateway

Advanced Settings

Proxy Server
Domain/Login Settings

User Domains

Password Management

Credentialz Pass-Through

Two-Factor Authentication

Anonymous Login

Client Device Identification

Auto-Launch
Downloads/Conneciors

General Settings

viworkspace Connectors

Other Downloads
Experience

Local Resources

L I —

Figure 52 New website

S—

6. Click the Validate

& New Web Access Site -
K New Website
New Website
Firewall/'Secure Gateway Specify the website that you would like to administer.

Enter the friendly name and URL of the \wieb Access site below.

Note that to set up a new \Web Access site. you must first run the Web Access Site Manager directly on your web
server. If you have already done this, and you have connectivity to the web site from this computer, you may click
the Import butten below. This will allow you to select the Web Access site.

If you do not have connectivity to the web server from this computer, you may enter the name and URL of the
Web Access site manually.

‘Web Access site:

Name: labcore

URL

hitp-//dvs-vwswallabcore

(emmple: http-/imy=erver.quest comivworkspace)

Click below to validate the URL. The wizard will attempt to contact the web server.

button to verify and click Next.
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The remaining settings will vary depending on your network environment and needs. For help
determining what is appropriate, refer to the Using Web Access and Secure Gateway sections of the
vWorkspace Administration Guide.

12.2.2 Installing vWorkspace Client (Connector)

The vWorkspace Connector allows users to establish a connection to the vWorkspace farm and receive a
list of authorized desktops and applications. Several versions exist for different platforms, but this section
describes the installation for vWorkspace Connector for Windows.

Copy the vasclient32 installer file from the vWorkspace installation folder, from the path
viWWorkspace x64\connectors\Windows\vasclient32.

Click OK and install flash, if required.
Click Finish and restart your computer, if prompted.

1. Right-click and click Run as administrator.
2. Click Next.

3. Accept EULA and proceed.

4. Enter customer information and click Next.
5. Click Next again to proceed.

6. Click Next.

7. Click Next.

8.

9.

Refer to the vWorkspace Connectors section of the viWorkspace Administration Guide for information on
configuration settings for the connector client.

12.3  Using Foglight for Virtual Desktops

For information about Foglight for Virtual Desktops, refer to the Foglight for Virtual Desktops
Administrator's Guide and the Foglight for Virtual Desktops User's Guide.
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Adding Hosts

This section describes the tasks to add hosts to the cluster.

Adding Nutanix Nodes

Refer to the Nutanix Web Console Guide for the procedure to expand an existing cluster.

Adding MS Failover Cluster Nodes

To add nodes to an existing failover cluster:

NOTE: Microsoft Failover Cluster is required only when the hypervisor is Hyper-V.

1. Start Failover Cluster Manager on an existing node.
2. Right-click Nodes > Add Nodes.
3. Inthe Add Node wizard dialog box, to select the new servers to be used as nodes, type or

browse through to the server name.
= Add Node Wizard -

%E}i Select Servers

Befara You Begn Selzct the servers 1o add to the chuster:
Validation Waming %
Corfimation Enter server name: || | | Browse...
Corfigure the Chaster  gpgen TG e com
VATH-N4test].com

Summary

|<meku.|a | Next = || Cancel |

Figure 53 Adding MS Failover Cluster Nodes using Failover Cluster Manager

4. Select No on the Validation Warning page and click Next.

5. Follow the on-screen instructions and add the other nodes.
6. Refer to section 6.3 in this guide to ensure the Placement Paths have been configured properly

in SCVMM for the newly added nodes.
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